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��������������������������������������������������������������� ������������������������������
���������������������������������������:

– �������������������������� 32U ������������

– ������������������ ������������������������������������������������������

– ������������������ ���������� U
������������������������������������������������������������ 32U

v ��������������������������������������������������������������� �����������������������������

v ����������������������������������������������������������

v ��������������������������������������������������������������������
������������������������������������������������������������������������������������������������

v ����������������������������������������� 760 x 230 ��. (30 x 80 ����).

v ��������������������������������, ����, �������, �����, �����������������������������������������

v ������������������ ����������������������������������������������������

v ������������������ �������������������������������������������������������������������

v ������������������������� 10 ����

v �������������������������������� ��������������������������������������:

– ��������������������������������������

– ��������������������������������������

– ������������������� ���������������� ����������������������������������������������
�����������������

v ���������������������������������������
���������������������������������������������������������������
�������������������������������������� ������������� ��������������������������
��������������������������������������������������������

(R002)

(L001)

(L002)
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(L003)

or

��������������������������������������������������������������� DHHS 21 CFR Subchapter J
���������������������� class 1 ��������������������� ���������������������������������� IEC 60825
����������������������� class 1
������������������������������������������������������������������������������

CAUTION:
�����������������������������������������������������: ������������, ��������������,
��������������, ���������������� ������������������������ Class 1 �������� ���������������������:

v ����������������
���������������������������������������������������������������������������������������������
�����������������������������������������������

v ��������������� ������������������
�������������������������������������������������������������
�����������������������������������������������������������

(C026)

��������������������� xi



CAUTION:
��������������������������������������������������������������������
�������������������������������������������������������������������������� Class 1 �����������
������������������������������������������������������������� (C027)

CAUTION:
����������������������������� Class 1M ������������������������������� (C028)

CAUTION:
��������������������������������������������� Class 3A ���� Class 3B �������
�����������������������: ��������������������������� ����������������,
������������������������������������, ������������������������������������ (C030)

CAUTION:
�������������������������� ���������������������������������������������� �������
������������������

����:
v ___ �������������������
v ___ ������������������������� 100°C (212°F)
v ___ ��������������

��������������������������� IBM �������� ������������
��������������������������������������������� �������������������� IBM
���������������������������������������� ��������������������� ���������������������
1-800-426-4333 �������������������������������������� ����������������������� (C003)

���������������������������������������� NEBS (Network Equipment-Building
System) GR-1089-CORE

���������������������������������� IBM ���������������������������������� NEBS (Network
Equipment-Building System) GR-1089-CORE:

������������������������������������������:
v �������������������������������������������

v ������������������� NEC (National Electrical Code) ���

����������������������������������������������������������
���������������������������������������������������� ���������������������������� �������
��������������������������������������������� OSP (outside plant) ����������������������
����������������������������������������������������������������������������� (��������� 2
�������� 4 �������������� GR-1089-CORE) ��������������� ������������ OSP ���������
����������������������������������������������������������������
�������������������������������������� OSP

Note: ��������������������������� ��������������������������������������������

������������������������������������������������������������ surge protection device (SPD)������

������������������������������ DC return ��������� ���� isolated DC return (DC-I)
������������������������������� ������� �������������������������������������
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Installing and configuring the Hardware Management Console

Describes how to install the HMC hardware, connect it to your managed system, and configure it for use.
You can perform these tasks yourself, or contact a service provider to perform these tasks for you. You
might be charged a fee by the service provider for this service.

Installation and configuration tasks
Learn about the tasks associated with different HMC installation and configuration tasks.

This section describes, at a high level, the tasks you must perform when you install and configure your
HMC. There are different ways you can install and configure your HMC. Find the situation that best
matches the task you want to perform.

Note: If you are managing POWER7® processor-based servers, the HMC must be at Version 7.7.2 or later.
For more information, see “Determining your HMC machine code version and release” on page 66.

Installing and configuring a new HMC with a new server
Learn more about the high-level tasks you must perform when installing and configuring a new HMC
with a new server.

Table 1. Tasks you need to perform when installing and configuring a new HMC with a new server

Task Where to find related information

1. Gather information and complete the Preinstallation
Configuration Worksheet.

“Preinstallation configuration worksheet for the HMC”
on page 16

“Preparing for HMC configuration” on page 16

2. Unpack the hardware.

3. Cable the HMC hardware. “Cabling your stand-alone HMC” on page 23

“Cabling your rack-mounted HMC” on page 34

4. Power on the HMC by pressing the power button.

5. Log in and launch the HMC web application.

6. Access the Guided setup wizard or use the HMC
menus to configure the HMC.

“Configuring the HMC by using the fast path through
the Guided Setup wizard” on page 49

“Configuring the HMC by using the HMC menus” on
page 49

7. Attach the server to the HMC.

Updating and upgrading your HMC code
Learn more about the high-level tasks you must perform when you update and upgrade your HMC code.

If you have an existing HMC and want to update or upgrade your HMC code, you must complete the
following high-level tasks:

© Copyright IBM Corp. 2013 1



Table 2. Tasks you need to perform when updating or upgrading HMC code

Task Where to find related information

1. Obtain the upgrade. “Upgrading your HMC software” on page 69

2. View the existing HMC machine code level.

3. Back up the managed system’s profile data.

4. Back up HMC data.

5. Record the current HMC configuration information.

6. Record remote command status.

7. Save upgrade data.

8. Upgrade the HMC software.

9. Verify that the HMC machine code upgrade installed
successfully

Migrating HMC Version 6 code to HMC Version 7 code
Learn more about the high-level tasks you must perform when you migrate from an HMC Version 6 to
an HMC Version 7.

If you have an existing HMC and want to migrate from Version 6 to Version 7, you must complete the
following high-level tasks:

Table 3. Tasks you need to perform when migrating an HMC Version 6 to an HMC Version 7

Task Where to find related information

1. Ensure your HMC hardware supports HMC Version 7
code.

2. Ensure that your HMC code level is 6.12 or higher. If
not, you must upgrade your existing HMC code.

“Determining your HMC machine code version and
release” on page 66

“Upgrading your HMC software” on page 69

3. Upgrade your HMC to Version 7. “Upgrading your HMC software” on page 69

4. Optional: upgrade your managed system's firmware
level to the highest available level.

2

5. If you have a second HMC, perform steps 1-4 for that
HMC.

Adding a second HMC to an existing installation
Learn more about the high-level tasks you must perform when adding a second HMC to your managed
system.

If you have an existing HMC and managed system and want to add a second HMC to this configuration,
do the following:

Table 4. Tasks you need to perform when adding a second HMC to an existing installation

Task Where to find related information

1. Ensure your HMC hardware supports HMC Version 7
code.

2. Gather information and complete the Preinstallation
Configuration Worksheet.

“Preinstallation configuration worksheet for the HMC”
on page 16

3. Unpack the hardware.
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Table 4. Tasks you need to perform when adding a second HMC to an existing installation (continued)

Task Where to find related information

4. Cable the HMC hardware. “Cabling your stand-alone HMC” on page 23

“Cabling your rack-mounted HMC” on page 34

5. Power on the HMC by pressing the power button.

6. Log in to the HMC.

7. The HMC code levels must match. Change the code
on one of the HMCs to match the code on the other.

“Determining your HMC machine code version and
release” on page 66

“Upgrading your HMC software” on page 69

8. Access the Guided setup wizard or use the HMC
menus to configure the HMC.

“Configuring the HMC by using the HMC menus” on
page 49

9. Configure this HMC for service using the Call-Home
Setup Wizard.

“Configuring the HMC so that it can contact service and
support” on page 59

10. Attach the server to the HMC.

HMC network connections
You can use different types of network connections to connect your HMC to managed systems. For more
information about how to configure the HMC to connect to a network, see “Configuring the HMC” on
page 49. For more information about using the HMC on a network, see the following:

Types of HMC network connections
Learn how to use the HMC remote management and service functions using your network.

The HMC supports the following types of logical communications:

HMC to managed system
Used to perform most of the hardware management functions, in which HMC issues control
function requests through the service processor of the managed system. The connection between
the HMC and the service processor is sometimes referred to as the service network. This
connection is required for managed system management.

HMC to logical partition
Used to collect platform-related information (hardware error events, hardware inventory) from
the operating systems running in the logical partitions, as well as to coordinate certain platform
activities (dynamic LPAR, concurrent repair) with those operating systems. If you want to use
service and error notification features, you must create this connection.

HMC to remote users
Provides remote users with access to HMC functions. Remote users can access the HMC in the
following ways:
v By using Secure Socket Shell (SSH) to access the HMC command line functions remotely

HMC to service and support
Used to transmit data, such as hardware error reports, inventory data, and microcode updates, to
and from your service provider. You can use this communications path to make automatic service
calls.

Your HMC can support up to four separate physical Ethernet interfaces, depending on the model. The
stand-alone version of the HMC supports only three HMC interfaces, using one integrated Ethernet
adapter and up to two plug-in adapters. Use each of these interfaces in the following ways:
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v Even though the network interfaces into the service processors are encrypted for the Secure Sockets
Layer (SSL) Protocol and password-protected, having a separate dedicated network can provide a
higher level of security for these interfaces.

v An open network interface would typically be used for the network connection between the HMC and
the logical partitions on the managed systems, for the HMC-to-logical partition communications. You
can also use this open network interface to manage the HMC remotely.

v Optionally, you can use a third interface to connect to logical partitions and manage the HMC
remotely. This interface can also be used as a separate HMC connection to different groups of logical
partitions. For example, you might want to have an administrative LAN that is separate from the LAN
on which all the usual business transactions are running. Remote administrators could access HMCs
and other managed units using this method. Sometimes the logical partitions are in different network
security domains, perhaps behind a firewall, and you might want to have different HMC network
connections into each of those two domains.

Web browser requirements for HMC

The Hardware Management Console (HMC) is supported by Microsoft Internet Explorer (IE) version 6.0
and 7.0, Firefox version 1.5.0.7 and 2.0.

If your browser is configured to use an Internet proxy, a local IP addresses should be included in the
exception list. Consult your network administrator for more information on the exception list. If you still
need to use the proxy to get to the HMC, enable Use HTTP 1.1 through proxy connections under the
Advanced tab in your Internet Options window.

Note: For Firefox version 2.0, ensure that you enable the JavaScript options to raise or lower windows
and move or resize existing windows. This feature allows you to switch easily between HMC tasks.
Perform the steps to enable the Javascript options:
1. Select Tools and Click Options
2. Select Content and Click Advanced
3. Select Move or resize existing windows and Raise or lower windows
4. Click OK

Session cookies need to be enabled in order for ASMI to work when connected to HMC remotely. The
asm proxy code saves session information and uses it. Follow the steps to enable the session cookies.

Enabling session cookies in Internet Explorer.
1. Select Tools and Click Internet Options
2. Select Privacy and Click Advanced
3. Ensure that the Always allow session cookies is checked. If not, select the Override automatic cookie

handling and select Always allow session cookies.
4. Select Prompt under First-party Cookies and Third-party Cookies
5. Click OK.

Enabling session cookies in Firefox.
1. Select Tools and click Options
2. Click Cookies
3. Select Allow sites to set cookies.
4. Select Exceptions and add HMC.
5. Click OK.
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Private and open networks in the HMC environment:

The HMC can be configured to use open and private networks. Private networks allow the use of a
selected range of nonroutable IP-addresses. A public, or "open" network describes a network connection
between the HMC to any logical partitions and to other systems on your regular network.

Private networks

The only devices on the HMC private network are the HMC itself and each of the managed systems to
which that HMC is connected. The HMC is connected to each managed system's FSP (Flexible Service
Processor).

On most systems, the FSP provides two Ethernet ports labeled HMC1 and HMC2. This allows you to
connect up to two HMCs.

Some systems have a dual-FSP option. In this situation, the second FSP acts as a "redundant" backup. The
basic setup requirements for a system with two FSPs are essentially the same as those without a second
FSP. The HMC must be connected to each FSP, so additional network hardware is required (for example,
a LAN switch or hub) when there is more than one FSP or there are multiple managed systems.

Note: Each FSP port on the managed system must be connected to only one HMC.

Public networks

The open network can be connected to a firewall or router for connecting to the Internet. Connecting to
the Internet allows the HMC to "call home" when there are any hardware errors that need to be reported.

The HMC itself provides its own firewall on each of its network interfaces. A basic firewall is
automatically configured when you run the HMC Guided Setup wizard, but you customize your firewall
settings after the initial HMC installation and configuration.

HMC as a DHCP server:

You can use the HMC as a Dynamic Host Configuration Protocol (DHCP) server.

Note: If you are using IPv6, the discovery process must be done manually. For IPv6, there is no
automatic discovery.

Deciding which connectivity method to use for the call-home server
Learn more about the connectivity options you have when you use the call-home server.

You can configure the HMC to send hardware service related information to IBM by using a LAN-based
Internet connection, or a dial-up connection over a modem.

You have two communication choices when configuring the LAN based Internet connection. The first
choice is to use standard Secure Sockets Layer (SSL). The SSL communication can be enabled to connect
to the Internet through your proxy server. SSL connectivity is more likely to be compliant with corporate
security guidelines. Your second option is to use a VPN connection.

Note: If your open network interface connection uses only Internet Protocol Version 6 (IPv6), you cannot
use Internet VPN to connect to support. For more information about the Protocols used, see “Choosing
an Internet Protocol” on page 7.

The advantages to using an Internet connection can include:
v Significantly faster transmission speed
v Reduced customer expense (for example, the cost of a dedicated analog telephone line)
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v Greater reliability

The following security characteristics are in effect, regardless of the connectivity method chosen:
v Remote Support Facility requests are always initiated from the HMC to IBM. An inbound connection is

never initiated from the IBM Service Support System.
v All data transferred between the HMC and the IBM Service Support System are encrypted using a

high-grade encryption. Depending upon the connectivity method chosen, it is encrypted using either
SSL or IPSec Encapsulating Security Payload (ESP).

v When initializing the encrypted connection the HMC authenticates the target destination as that of the
IBM Service Support System.

Data sent to the IBM Service Support System consists solely of information about hardware problems and
configuration. No application or customer data is transmitted to IBM.

Using an indirect Internet connection with a proxy server

If your installation requires the HMC to be on a private network, you may be able to connect indirectly
to the Internet using an SSL proxy, which can forward requests to the Internet. One of the other potential
advantages of using an SSL proxy is that the proxy may support logging and audit facilities.

To forward SSL sockets, the proxy server must support the basic proxy header functions (as described in
RFC 2616) and the CONNECT method. Optionally, basic proxy authentication (RFC 2617) may be
configured so that the HMC authenticates before attempting to forward sockets through the proxy server.

For the HMC to communicate successfully, the client's proxy server must allow connections to port 443.
You can configure your proxy server to limit the specific IP addresses to which the HMC can connect. See
“Internet SSL address lists” on page 7 for a list of IP addresses.

Using a direct Internet SSL connection

If your HMC can be connected to the Internet, and the external firewall can be set up to allow established
TCP packets to flow outbound to the destinations described in “Internet SSL address lists” on page 7, you
can use a direct Internet connection.
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Using Internet SSL to connect to remote support
All the communications are handled through TCP sockets initiated by the HMC and use a high-grade
SSL to encrypt the data that is transmitted. The destination TCP/IP addresses are published (see “Internet
SSL address lists”) so that external firewalls can be configured to allow these connections.

Note: The standard HTTPS port 443 is used for all communications.

The HMC can be enabled to connect directly to the Internet or to connect indirectly from a proxy server
provided by the customer. The decision about which of these approaches works best for your installation
depends on the security and networking requirements of your enterprise. The HMC (directly or through
the SSL proxy) uses the following addresses when it is configured to use Internet SSL connectivity.

Choosing an Internet Protocol
Determine the IP address version used when the HMC connects to your service provider.

Most users use Internet Protocol Version 4 (IPv4) to connect to a service provider. IPv4 addresses appear
in the format representing the four bytes of the IPv4 address, separated by periods (for example,
9.60.12.123) to access the Internet. You can also use Internet Protocol Version 6 (IPv6) to connect to a
service provider. IPv6 is often used by network administrators to ensure unique address space. If you are
unsure of the Internet Protocol used by your installation, contact your network administrator. For more
information about using each version, see “Setting the IPv4 address” on page 55 and “Setting the IPv6
address” on page 56.

Internet SSL address lists
Learn about the addresses the HMC uses when it is using Internet SSL connectivity.

The HMC uses the following IPv4 addresses to contact IBM service and support when it is configured to
use Internet SSL connectivity.

The following IPv4 addresses are for all locations:
v 129.42.26.224
v 129.42.34.224
v 129.42.42.224
v 170.225.15.41
v 129.42.56.216
v 129.42.58.216
v 129.42.60.216

The following IPv4 addresses are for the Americas:
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v 129.42.160.48
v 129.42.160.49
v 207.25.252.200
v 207.25.252.204

The following IPv4 addresses are for all locations other than the Americas:
v 129.42.160.48
v 129.42.160.50
v 207.25.252.200
v 207.25.252.205

Note: When configuring a firewall to allow an HMC to connect to these servers, only the IP addresses
specific to the geographic region are required.

The HMC uses the following IPv6 addresses to contact IBM service and support when it is configured to
use Internet SSL connectivity:
v 2620:0:6C0:1::1000
v 2620:0:6C1:1::1000
v 2620:0:6C2:1::1000

Using a virtual private network to connect to remote support
A virtual private network (VPN) provides security when connecting to remote support.

A VPN gives users the privacy of a separate network over public lines by substituting encryption and
other security measures for the physically separate network lines of traditional private networks. In
addition to being able to be used for outbound connectivity, a VPN connection can also be configured on
an as-needed basis to support remote service requests.

It is system administrator's responsibility to provide an Internet connection. The firewall may also limit
the specific IP addresses to which the HMC can connect. If you need to configure your firewall to limit
the IP addresses, see“VPN server address list” for a list of addresses you can use.

For more information about how to connect to the Internet using a LAN-based VPN, see “Configuring
the HMC network types” on page 50.

VPN server address list
Lists the servers used by an HMC when the HMC is configured to use Internet VPN connectivity.
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The following servers are used by an HMC when it is configured to use Internet VPN connectivity. All
connections use ESP and UDP on port 500 and port 4500 when a Network Address Translation (NAT)
firewall is being used.
v 129.42.160.16 IBM VPN Server
v 207.25.252.196 IBM VPN Server

Using the telephone and modems to connect to remote support
If you want to use a modem to connect to remote support, you must provide a dedicated analog line to
connect to the HMC modem. The HMC uses the modem to dial the global network and to connect to
IBM service and support.

For more information about connecting to remote support using the telephone and modems, see
“Configuring the HMC network types” on page 50.

Using multiple call-home servers
This topic describes what you need to know when you decide to use more than one call-home server.

To avoid a single point of failure, configure the HMC to use multiple call-home servers. The first
available call-home server attempts to handle each service event. If the connection or transmission fails
with this call-home server, the service request is retried using the other available call-home servers until
one is successful or all have been tried.

The connected HMC that has been identified by problem analysis to be the primary analyzing console for
a given managed system will report the problem. This primary console will also replicate the problem
report to any secondary HMC. This secondary HMC must be recognized on the network by the primary
HMC. A secondary HMC is recognized by the primary HMC as an additional call-home server when:
v The primary HMC is configured to use "discovered" call-home servers and the call-home server is

either on the same subnet as the primary HMC or it manages the same system
v The call-home server has been manually added to the list of call-home server consoles available for

outbound connectivity

Choosing network settings on the HMC
Learn about the network settings you can use on the HMC.
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HMC network connections
You can use different types of network connections to connect your HMC to managed systems. For more
information about how to configure the HMC to connect to a network, see “Configuring the HMC” on
page 49. For more information about using the HMC on a network, see the following:

Types of HMC network connections
Learn how to use the HMC remote management and service functions using your network.

The HMC supports the following types of logical communications:

HMC to managed system
Used to perform most of the hardware management functions, in which HMC issues control
function requests through the service processor of the managed system. The connection between
the HMC and the service processor is sometimes referred to as the service network. This
connection is required for managed system management.

HMC to logical partition
Used to collect platform-related information (hardware error events, hardware inventory) from
the operating systems running in the logical partitions, as well as to coordinate certain platform
activities (dynamic LPAR, concurrent repair) with those operating systems. If you want to use
service and error notification features, you must create this connection.

HMC to remote users
Provides remote users with access to HMC functions. Remote users can access the HMC in the
following ways:
v By using Secure Socket Shell (SSH) to access the HMC command line functions remotely

HMC to service and support
Used to transmit data, such as hardware error reports, inventory data, and microcode updates, to
and from your service provider. You can use this communications path to make automatic service
calls.

Your HMC can support up to four separate physical Ethernet interfaces, depending on the model. The
stand-alone version of the HMC supports only three HMC interfaces, using one integrated Ethernet
adapter and up to two plug-in adapters. Use each of these interfaces in the following ways:
v Even though the network interfaces into the service processors are encrypted for the Secure Sockets

Layer (SSL) Protocol and password-protected, having a separate dedicated network can provide a
higher level of security for these interfaces.

v An open network interface would typically be used for the network connection between the HMC and
the logical partitions on the managed systems, for the HMC-to-logical partition communications. You
can also use this open network interface to manage the HMC remotely.

v Optionally, you can use a third interface to connect to logical partitions and manage the HMC
remotely. This interface can also be used as a separate HMC connection to different groups of logical
partitions. For example, you might want to have an administrative LAN that is separate from the LAN
on which all the usual business transactions are running. Remote administrators could access HMCs
and other managed units using this method. Sometimes the logical partitions are in different network
security domains, perhaps behind a firewall, and you might want to have different HMC network
connections into each of those two domains.

Web browser requirements for HMC

The Hardware Management Console (HMC) is supported by Microsoft Internet Explorer (IE) version 6.0
and 7.0, Firefox version 1.5.0.7 and 2.0.
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If your browser is configured to use an Internet proxy, a local IP addresses should be included in the
exception list. Consult your network administrator for more information on the exception list. If you still
need to use the proxy to get to the HMC, enable Use HTTP 1.1 through proxy connections under the
Advanced tab in your Internet Options window.

Note: For Firefox version 2.0, ensure that you enable the JavaScript options to raise or lower windows
and move or resize existing windows. This feature allows you to switch easily between HMC tasks.
Perform the steps to enable the Javascript options:
1. Select Tools and Click Options
2. Select Content and Click Advanced
3. Select Move or resize existing windows and Raise or lower windows
4. Click OK

Session cookies need to be enabled in order for ASMI to work when connected to HMC remotely. The
asm proxy code saves session information and uses it. Follow the steps to enable the session cookies.

Enabling session cookies in Internet Explorer.
1. Select Tools and Click Internet Options
2. Select Privacy and Click Advanced
3. Ensure that the Always allow session cookies is checked. If not, select the Override automatic cookie

handling and select Always allow session cookies.
4. Select Prompt under First-party Cookies and Third-party Cookies
5. Click OK.

Enabling session cookies in Firefox.
1. Select Tools and click Options
2. Click Cookies
3. Select Allow sites to set cookies.
4. Select Exceptions and add HMC.
5. Click OK.

Private and open networks in the HMC environment:

The HMC can be configured to use open and private networks. Private networks allow the use of a
selected range of nonroutable IP-addresses. A public, or "open" network describes a network connection
between the HMC to any logical partitions and to other systems on your regular network.

Private networks

The only devices on the HMC private network are the HMC itself and each of the managed systems to
which that HMC is connected. The HMC is connected to each managed system's FSP (Flexible Service
Processor).

On most systems, the FSP provides two Ethernet ports labeled HMC1 and HMC2. This allows you to
connect up to two HMCs.

Some systems have a dual-FSP option. In this situation, the second FSP acts as a "redundant" backup. The
basic setup requirements for a system with two FSPs are essentially the same as those without a second
FSP. The HMC must be connected to each FSP, so additional network hardware is required (for example,
a LAN switch or hub) when there is more than one FSP or there are multiple managed systems.

Note: Each FSP port on the managed system must be connected to only one HMC.
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Public networks

The open network can be connected to a firewall or router for connecting to the Internet. Connecting to
the Internet allows the HMC to "call home" when there are any hardware errors that need to be reported.

The HMC itself provides its own firewall on each of its network interfaces. A basic firewall is
automatically configured when you run the HMC Guided Setup wizard, but you customize your firewall
settings after the initial HMC installation and configuration.

HMC as a DHCP server:

You can use the HMC as a Dynamic Host Configuration Protocol (DHCP) server.

Note: If you are using IPv6, the discovery process must be done manually. For IPv6, there is no
automatic discovery.

Deciding which connectivity method to use for the call-home server
Learn more about the connectivity options you have when you use the call-home server.

You can configure the HMC to send hardware service related information to IBM by using a LAN-based
Internet connection, or a dial-up connection over a modem.

You have two communication choices when configuring the LAN based Internet connection. The first
choice is to use standard Secure Sockets Layer (SSL). The SSL communication can be enabled to connect
to the Internet through your proxy server. SSL connectivity is more likely to be compliant with corporate
security guidelines. Your second option is to use a VPN connection.

Note: If your open network interface connection uses only Internet Protocol Version 6 (IPv6), you cannot
use Internet VPN to connect to support. For more information about the Protocols used, see “Choosing
an Internet Protocol” on page 7.

The advantages to using an Internet connection can include:
v Significantly faster transmission speed
v Reduced customer expense (for example, the cost of a dedicated analog telephone line)
v Greater reliability

The following security characteristics are in effect, regardless of the connectivity method chosen:
v Remote Support Facility requests are always initiated from the HMC to IBM. An inbound connection is

never initiated from the IBM Service Support System.
v All data transferred between the HMC and the IBM Service Support System are encrypted using a

high-grade encryption. Depending upon the connectivity method chosen, it is encrypted using either
SSL or IPSec Encapsulating Security Payload (ESP).

v When initializing the encrypted connection the HMC authenticates the target destination as that of the
IBM Service Support System.

Data sent to the IBM Service Support System consists solely of information about hardware problems and
configuration. No application or customer data is transmitted to IBM.

Using an indirect Internet connection with a proxy server

If your installation requires the HMC to be on a private network, you may be able to connect indirectly
to the Internet using an SSL proxy, which can forward requests to the Internet. One of the other potential
advantages of using an SSL proxy is that the proxy may support logging and audit facilities.
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To forward SSL sockets, the proxy server must support the basic proxy header functions (as described in
RFC 2616) and the CONNECT method. Optionally, basic proxy authentication (RFC 2617) may be
configured so that the HMC authenticates before attempting to forward sockets through the proxy server.

For the HMC to communicate successfully, the client's proxy server must allow connections to port 443.
You can configure your proxy server to limit the specific IP addresses to which the HMC can connect. See
“Internet SSL address lists” on page 7 for a list of IP addresses.

Using a direct Internet SSL connection

If your HMC can be connected to the Internet, and the external firewall can be set up to allow established
TCP packets to flow outbound to the destinations described in “Internet SSL address lists” on page 7, you
can use a direct Internet connection.

Using Internet SSL to connect to remote support
All the communications are handled through TCP sockets initiated by the HMC and use a high-grade
SSL to encrypt the data that is transmitted. The destination TCP/IP addresses are published (see “Internet
SSL address lists” on page 7) so that external firewalls can be configured to allow these connections.

Note: The standard HTTPS port 443 is used for all communications.

The HMC can be enabled to connect directly to the Internet or to connect indirectly from a proxy server
provided by the customer. The decision about which of these approaches works best for your installation
depends on the security and networking requirements of your enterprise. The HMC (directly or through
the SSL proxy) uses the following addresses when it is configured to use Internet SSL connectivity.
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Choosing an Internet Protocol
Determine the IP address version used when the HMC connects to your service provider.

Most users use Internet Protocol Version 4 (IPv4) to connect to a service provider. IPv4 addresses appear
in the format representing the four bytes of the IPv4 address, separated by periods (for example,
9.60.12.123) to access the Internet. You can also use Internet Protocol Version 6 (IPv6) to connect to a
service provider. IPv6 is often used by network administrators to ensure unique address space. If you are
unsure of the Internet Protocol used by your installation, contact your network administrator. For more
information about using each version, see “Setting the IPv4 address” on page 55 and “Setting the IPv6
address” on page 56.

Internet SSL address lists
Learn about the addresses the HMC uses when it is using Internet SSL connectivity.

The HMC uses the following IPv4 addresses to contact IBM service and support when it is configured to
use Internet SSL connectivity.

The following IPv4 addresses are for all locations:
v 129.42.26.224
v 129.42.34.224
v 129.42.42.224
v 170.225.15.41
v 129.42.56.216
v 129.42.58.216
v 129.42.60.216

The following IPv4 addresses are for the Americas:
v 129.42.160.48
v 129.42.160.49
v 207.25.252.200
v 207.25.252.204

The following IPv4 addresses are for all locations other than the Americas:
v 129.42.160.48
v 129.42.160.50
v 207.25.252.200
v 207.25.252.205

Note: When configuring a firewall to allow an HMC to connect to these servers, only the IP addresses
specific to the geographic region are required.

The HMC uses the following IPv6 addresses to contact IBM service and support when it is configured to
use Internet SSL connectivity:
v 2620:0:6C0:1::1000
v 2620:0:6C1:1::1000
v 2620:0:6C2:1::1000

Using a virtual private network to connect to remote support
A virtual private network (VPN) provides security when connecting to remote support.

A VPN gives users the privacy of a separate network over public lines by substituting encryption and
other security measures for the physically separate network lines of traditional private networks. In
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addition to being able to be used for outbound connectivity, a VPN connection can also be configured on
an as-needed basis to support remote service requests.

It is system administrator's responsibility to provide an Internet connection. The firewall may also limit
the specific IP addresses to which the HMC can connect. If you need to configure your firewall to limit
the IP addresses, see“VPN server address list” on page 8 for a list of addresses you can use.

For more information about how to connect to the Internet using a LAN-based VPN, see “Configuring
the HMC network types” on page 50.

VPN server address list
Lists the servers used by an HMC when the HMC is configured to use Internet VPN connectivity.

The following servers are used by an HMC when it is configured to use Internet VPN connectivity. All
connections use ESP and UDP on port 500 and port 4500 when a Network Address Translation (NAT)
firewall is being used.
v 129.42.160.16 IBM VPN Server
v 207.25.252.196 IBM VPN Server

Using the telephone and modems to connect to remote support
If you want to use a modem to connect to remote support, you must provide a dedicated analog line to
connect to the HMC modem. The HMC uses the modem to dial the global network and to connect to
IBM service and support.
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For more information about connecting to remote support using the telephone and modems, see
“Configuring the HMC network types” on page 50.

Using multiple call-home servers
This topic describes what you need to know when you decide to use more than one call-home server.

To avoid a single point of failure, configure the HMC to use multiple call-home servers. The first
available call-home server attempts to handle each service event. If the connection or transmission fails
with this call-home server, the service request is retried using the other available call-home servers until
one is successful or all have been tried.

The connected HMC that has been identified by problem analysis to be the primary analyzing console for
a given managed system will report the problem. This primary console will also replicate the problem
report to any secondary HMC. This secondary HMC must be recognized on the network by the primary
HMC. A secondary HMC is recognized by the primary HMC as an additional call-home server when:
v The primary HMC is configured to use "discovered" call-home servers and the call-home server is

either on the same subnet as the primary HMC or it manages the same system
v The call-home server has been manually added to the list of call-home server consoles available for

outbound connectivity

Preparing for HMC configuration
Use this section to gather required configuration settings that you need to know before you begin the
configuration steps.

Note: Additional connectivity and security information is available. For more information, see HMC
Connectivity Security

Preinstallation configuration worksheet for the HMC
Use this worksheet to have the installation information you need ready for the installation.
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Network Settings

LAN Interface: Choose the available adapters (such as eth0, eth1) that will be used by this HMC to
connect to managed systems, logical partitions, service and support, and remote users. See “HMC
network connections” on page 3 for more information. Connectivity from the HMC can either be on a
private or open network.

Ethernet Adapter Speed and Duplex
Enter the desired Ethernet adapter speed and duplex mode. The autodetection option determines
which option is optimal if you are not sure which speed and duplex would produce optimum
results for your hardware. Default = Autodetection Media speed specifies the speed in duplex
mode of an Ethernet adapter. Select Autodetection unless you have a requirement to specify a
fixed media speed. Any device connected to the FSP (switches/HMC), must be set to Auto
(Speed) / Auto (Duplex) mode, as it is the default FSP setting and cannot be changed.

eth0 eth1 eth2 eth3

Select speed and duplex mode

Media speed
(Autodetection,
10/100/1000
Full/Half Duplex)

For more information about private and open networks, see “Private and open networks in the HMC
environment” on page 5.

eth0 eth1 eth2 eth3

Specify Private or
Open network for
each adapter

Dynamic Host Configuration Protocol (DHCP) provides an automated method for dynamic client
configuration. You can specify this HMC as a DHCP server. If this is the first or only HMC on the private
network, enable the HMC as a DHCP server. When you do this, the managed systems on the network
will be automatically configured and discovered by the HMC.

For Ethernet adapters specified as Private networks, complete the following table:

eth0 eth1

Do you want to specify this HMC as
a DHCP server? (yes/no)

If "yes," record the IP address range
you want to use

For Ethernet adapters specified as open networks, complete the following tables. For more information
about the different Internet Protocol versions, see “Choosing an Internet Protocol” on page 7.

Using IPv6
If you are using IPv6, talk to your network administrator and decide how you want to obtain IP
addresses. Then, complete the following tables:
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eth0 eth1 eth2 eth3

Are you using a
statically-assigned IP
address? If yes,
record that address
here.

eth0 eth1 eth2 eth3

Are you getting IP
addresses from a
DHCP server?
(Yes/No)

eth0 eth1 eth2 eth3

Are you getting IP
addresses from an
IPv6 router?

For more information about setting IPv6 addresses, see “Setting the IPv6 address” on page 56.
For more information about using only IPv6 addresses, see “Using only IPv6 addresses” on page
56.

Using IPv4

Complete the following tables for Ethernet adapters specified as open networks using IPv4.

eth0 eth1 eth2 eth3

Do you want to
obtain an IP address
automatically?
(yes/no)

If no, list the specified address below:

TCP/IP Interface
Address:

TCP/IP Interface
Network Mask:

Firewall Settings:

Would you like to
configure HMC
firewall settings?
(yes/no)

If yes, list the applications and IP addresses that should be allowed through the firewall:

TCP/IP Information
A unique TCP/IP address is required for each node, both for Support Element (SE) and
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Hardware Management Console (HMC). The assigned network mask is used to generate
a unique address, by default, for the local private LAN. If the nodes will be connected
into a larger network with an administered TCP/IP address, you can specify the TCP/IP
address to be used. The default is generated by the system.

Firewall Settings
HMC firewall settings create a security barrier that allows or denies access to specific
network applications on the HMC. You can specify these control settings individually for
each physical network interface, allowing you control over which HMC network
applications can be accessed on each network.

If you have configured at least one adapter as an Open network adapter, you must provide the following
additional information to enable your HMC to access the LAN:

Local host information

HMC host name:

Domain name:

Description of HMC:

Gateway information

Gateway Address: (nnn.nnn.nnn.nnn)

Gateway device:

DNS enablement

Do you want to use DNS? (yes/no)

If “yes”, specify DNS Server Search Order below:

1.

2.

Domain suffix search order:

1.

2.

Local Host Information
To identify your Hardware Management Console (HMC) to the network, enter the HMC's host
name and domain name. Unless you are using only short host names on your network, enter a
fully qualified host name. Domain name example: name.yourcompany.com

Gateway Information
To define a default gateway, fill in the TCP/IP address to be used for routing IP packets. The
gateway address informs each computer or network device when to send data if the target station
is not located on the same subnet as the source.

DNS Enablement
The Domain Name System (DNS) is used to provide a standard naming convention for locating
IP-based computers. By defining DNS servers, you can use host names to identify servers and
Hardware Management Consoles (HMCs) rather than IP addresses.

DNS Server Search Order
Enter the IP addresses of DNS servers to be searched for mapping the host names and IP
addresses. This search order is available only when DNS is enabled.

Domain Suffix Search Order
Enter the domain suffixes you are using. The HMC uses domain suffixes to append to
unqualified names for DNS searches. Suffixes are searched in the order in which they are listed.
This search order is available only when DNS is enabled.
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Email notification

List email contact information if you wish to be notified by email when hardware problem events occur
on your system.

Email Addresses:

SMTP server:

Port:

Errors to be notified:

Only call-home problem events

All problem events

SMTP server
Type the simple mail transfer Protocol (SMTP) address of the server to be notified of a system
event. An example of an SMTP server name is relay.us.ibm.com.

SMTP is the Protocol used to send email. When using SMTP, a client sends a message and
communicates with the SMTP server using the SMTP Protocol.

If you do not know the SMTP address of your server or are not sure, contact your network
administrator.

Port Type the port number of the server to be notified of a system event, or use the default port.

Email addresses to be notified
Enter configured email addresses to be notified when a system event occurs.
v Select Only call-home problem events to only receive notification when events occur that

create a call-home function.
v Select All problem events to receive notification when any events occur.

Service Contact Information

Company name

Administrator name

Email address

Phone number

Alternate phone number

Fax number

Alternate fax number

Street address

Street address 2

City or locality

State

Postal code

Country or region
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Location of HMC (if same as above administrator
address, specify “same”):

Street address

Street address 2

City of locality

State

Postal code

Country or region

Service authorization and connectivity

Select the type of connection to contact your service provider. For a description of these methods
including security characteristics and configuration requirements, see “Deciding which connectivity
method to use for the call-home server” on page 5.

_____ Secure Sockets Layer (SSL) through the Internet

_____ Dialup from the local HMC

_____ Virtual private network (VPN) through the Internet

Secure Sockets Layer (SSL) through the Internet:
If you have an existing Internet connection from your HMC, you can use it to call your service
provider. You can connect directly to your service provider by using encrypted Secure Sockets
Layer (SSL) using the existing Internet connection. select Use SSL Proxy if you want to configure
the use of encrypted SSL using an indirect connection using an SSL Proxy.

Use SSL proxy? (yes/no)

If yes, list information below:

Address:

Port:

Authenticate with the SSL
Proxy?

If yes, list information below:

User:

Password:

Internet connection Protocol used

For more information about the different Internet Protocols, see “Choosing an Internet Protocol”
on page 7.

___ IPv4

___ IPv6

___ IPv4 and IPv6

Dial-up from the local HMC
Enter the dial-up information to configure your local modem. Specify which telephone numbers
to use to dial your service provider. When you are connecting, the telephone numbers will be
dialed in the order in which they are listed.

Dial prefix: ________________
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Tone: ________________

Pulse: ________________

Wait for dial tone? ________________

Enable speaker? ________________

Virtual Private Network (VPN)
If you have an existing Internet connection from your HMC, you can use it to call your service
provider. You can connect directly to your service provider by virtual private network (VPN)
using the existing Internet connection.

Note: If you select Virtual Private Network (VPN) through the Internet, you will not be directed
to select any other options.

Call-home servers

Determine which HMCs you want to configure to connect to service and support as call-home servers.
For more information about using multiple call-home servers, see “Using multiple call-home servers” on
page 9.

___ This HMC

___ Another HMC

If you checked Another HMC, list the other HMCs that have been configured as call-home servers here:

Table 5. Other HMCs that have been configured as call-home servers

List of HMC host names or IP addresses that have been configured as call-home servers

Additional Support Benefits

My Systems and Premium Search

List your IBM ID __________________________

List any additional IBM
IDs

__________________________

In order to access valuable, customized support information in the My Systems and Premium
Search sections of the Electronic Services website, Customers must register their IBM ID with this
system. If you do not already have one, you can register for an IBM ID at: www.ibm.com/
account/profile.

Note: IBM provides personalized Web functions that use information collected by the IBM
Electronic Service Agent™ application. To use these functions, you must first register on the IBM
Registration website at http://www.ibm.com/account/profile.

To authorize users to use the Electronic Service Agent information to personalize the Web
functions, enter your IBM ID that you registered on the IBM Registration website. Go to
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http://www.ibm.com/support/electronic to see the valuable support information available to
customers that register an IBM ID with their systems.

Setting up the HMC
You must set up the HMC hardware before you configure the HMC software. Learn more about setting
up a desk-side HMC or a rack-mounted HMC.

Cabling your stand-alone HMC
Position the HMC and cable each of the hardware components.

If an HMC is used to manage any POWER7 processor-based system, the HMC must be a C05 or later
stand-alone HMC.
1. Ensure that you position the HMC in the correct location.
2. Attach the monitor cable to the monitor connector, and tighten the screws.
3. Attach the power cord to the monitor.
4. Ensure that the voltage selection switch on the HMC is set to the voltage used in your world region.

The voltage selection switch is red and is located near the power connector. Move the switch so that
the voltage used at your location is displayed.

5. Plug the power cord into the HMC.
6. Connect the keyboard and mouse to the HMC.
7. Connect the optional modem:

Note: During the installation and configuration of the HMC, the modem might automatically dial
out as the HMC follows routine call-out procedures. This is usual behavior.
If you are connecting an optional external modem, do the following:

Note: You can use other connectivity methods to send error information to IBM.
a. If you have not already done so, connect the modem data cable to the external HMC modem.
b. Connect the modem data cable to the system port on the HMC that is labeled with the following

symbol:

c. Use the telephone cable to connect the line port of the external modem to the analog telephone
jack on your wall.

If you are connecting to an optional integrated modem, use the data cable to connect the integrated HMC
modem to the appropriate data source. For example, use the telephone cable to connect the HMC
modem line port to the analog jack on your wall.

Note: You can use other connectivity methods to send error information to IBM.
8. If your managed system is already installed, you can verify that the Ethernet cable connection is

active by observing the green status lights at both the HMC and managed system Ethernet ports as
your installation progresses.

9. Connect Ethernet Connector 1 on the HMC to the LINK HMC1 port on the managed system.
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10. If you are connecting a second HMC to your managed server, connect to the Ethernet port that is
labeled LINK HMC2 on the managed server.

11. If you use an external modem, plug the modem power supply cord into the HMC modem.
12. Plug the power cords for the monitor, HMC, and HMC external modem into electrical outlets. If you

are connecting this HMC to a new managed system, do not connect the managed system to a power
source at this time.

Next, you will need to configure your HMC software. Continue with “Configuring the HMC” on page
49.
Related concepts:
“Deciding which connectivity method to use for the call-home server” on page 5
Learn more about the connectivity options you have when you use the call-home server.
“HMC network connections” on page 3

Installing the 7310-CR4 HMC into a rack
This section describes how to install the 7310-CR4 HMC into a rack. This is a customer task.

If an HMC is used to manage any POWER7 processor-based system, the HMC must be a CR3, or later,
model rack-mounted HMC.

The following is a rear-view of the 7310–CR4:
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To install the 7310-CR4 HMC into a rack, complete the following steps:
1. Complete a parts inventory. See Completing a parts inventory.
2. Locate the rack-mounting hardware kit and the system rail assemblies that were included with your

system unit.

Table 6. Rail kit parts

Sliding-rail kit parts

A Slide rails

B Cable-management arm mounting plate

C Cable-management arm

D Cable-management bracket

E Cable-management support bracket and security tab

F Latch strikes (2)

G Screws (6)

Important: This system unit is 1 EIA unit high; you will need this information to complete the
installation.

Completing a parts inventory
You might need to complete a parts inventory. Use the procedure in this section to perform this task.

If you have not done so, complete a parts inventory before proceeding with the installation:
1. Locate the kitting report in an accessory box.

Figure 1. Rear-view of the 7310–CR4

Figure 2. Rail Kit
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2. Ensure that you received all the parts that were ordered.

If there are incorrect, missing, or damaged parts, contact your IBM reseller or IBM sales and support.

Determining the location
You might need to determine where to install the system in the rack. This section includes procedures so
that you can perform these tasks.

Before installing the HMC into a rack, complete the following steps:
1. Plan where you will place the units. Place the larger and heavier units in the lower part of the rack.
2. If the rack contains filler panels, remove the filler panels to allow access to the inside of the rack

enclosure where you plan to place the unit.

3. Remove the front and back rack doors if necessary.
4. Follow the instructions for marking the location without a template, see Marking the location without

a rack-mounting template.

Figure 3. Removing the filler panels.
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Marking the location without using a rack-mounting template:

You can mark the location without using a template.

A rack-mounting template is not included with this system. These systems are 1 EIA unit high.

To determine the mounting location, complete the following steps:
1. Determine to place the system in the rack. Record the EIA location.

Note: An EIA unit on your rack consists of a grouping of three holes.
2. Facing the front of the rack and working from the right side, place a supplied self-adhesive dot next

to the top hole of the EIA unit.

Note: The self-adhesive dots are used to aid in identifying locations on the rack. If you no longer
have any of the dots, use some other form of marking tool to aid you in identifying hole locations (for
example, tape, a marker, or pencil). If you are installing slide rails, place a mark or self-adhesive dot
on the lower and the middle hole of each EIA unit.

3. Place another self-adhesive dot next to the bottom hole of the above EIA unit.

Note: If you are counting the holes, begin with the hole identified by the first dot and count up two
holes. Place the second dot next to the third hole.

4. Repeat step 1 for the corresponding holes located on the left side of the rack.
5. Go to the rear of the rack.
6. On the right side, find the EIA unit that corresponds to the bottom EIA unit marked on the front of

the rack.
7. Place a self-adhesive dot at the bottom EIA unit.
8. Place a self-adhesive dot at the top hole of the EIA unit.
9. Mark the corresponding holes on the left side of the rack.

Installing the slide rails into the rack
To install slide rails into the rack, use this procedure.

To install the slide rails into the rack, complete the following steps:
1. Insert the right slide rail (A), which is marked right, into the rack mounting flange (B) locations, on

the back right side of the rack. The two rail pins will protrude through the bottom and middle holes
(B) on the EIA unit.
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2. Push on the end of the rail (A) to compress the rail's spring-loaded mechanism, and insert the rail
into the mounting flange (B) locations, on the right side of the rack. The rail will decompress and the
two rail pins will protrude through the bottom and middle holes (B) on the EIA unit.

3. Repeat steps 1 on page 27-2 to install the left slide rail, which is marked left, into the rack.

Figure 4. Installing the right slide rail into the back of the rack

Figure 5. Installing the right slide rail into the front of the rack
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4. From the front of the rack, place the latch strike (C) over the pins. Finger-tighten the captive screw
(D) into the top pin in the front of the right slide rail (A).

5. Repeat the previous step to install the latch strike on the front of the left slide rail.
6. Move to the rear of the rack. Finger-tighten screw (F) to attach the cable-management arm mounting

bracket (E) to the back of the left rail (G).

Figure 6. Installing the latch strike to the front of the rails
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7. If you do not plan to transport this system, continue with “Installing the HMC on the slide rails” on
page 31. If you plan to transport this system, insert screw (I) to attach the cable-management arm
support bracket (H) to the back right side of the rail (A). Finger-tighten the screw.
The support bracket of the cable-management arm can be used to secure the cable-management arm
during transportation. If the mechanism is engaged after the cable-management arm is installed, you
will not be able to slide the system from the rack.

Figure 7. Attaching the cable-management bracket to the back-left rail

Figure 8. Attaching the support bracket of the cable-management to the back-right rail.
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Installing the HMC on the slide rails
You might need to install the HMC on the slide rails. Use the procedure in this section to perform this
task.

Before installing the HMC on the slide rails, ensure that the stabilizers are extended and the rack
stabilizer bracket is attached to the bottom front of the rack to prevent the rack from falling forward
when the rails are pulled out of the rack.

To install the HMC on the slide-rail assembly, complete the following steps:
1. Remove the shipping bracket that covers the power supplies from the right rear of the HMC. To

remove the shipping bracket, push to the bracket to the right and swivel the shipping bracket off the
HMC.

2. From the front of the rack, fully extend the slide rails until the rails lock into place in the extended
position (A).
Attention: The latch strikes on the front of the rail and the cable-management arm brackets must be
installed before installing an HMC onto the rails. If these parts are not installed, the installation may
cause the rails to compress and the HMC may fall out of the rack.

Important: This unit weighs approximately 17 kg (37 pounds). Be sure that you can safely support
this weight when placing the HMC into the rack.

3. Lift the HMC to the height of the rails, and position the set of wheels (B), at the rear of the HMC,
between the rail guides.

Figure 9. Extending the slide rails
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4. Push the HMC into the slide rails until the slide release catches (C) lock into place. This locks the
system in the service position on the slides. You will hear an audible click.

5. Press the front-slide rail release latches (D) on both sides of the slide rails.
6. Slide the HMC into and out of the rack to verify that the HMC moves freely without binding.

Important: Do not, under any circumstances, force the HMC into the slide rails. If the HMC does not
slide freely into the rack, completely remove the HMC from the rails. After the HMC is clear of the
rails, reposition the HMC, then reinsert the HMC into the rails. Repeat this process until the HMC
slides freely into the rack.

7. Push the HMC into place until the rack latches (F) lock into place.

Figure 10. Installing the HMC on the slide rails.

Figure 11. Slide the HMC into the rack
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8. Completely tighten each of the four screws that were installed in the front and back of both rails.
9. If the rack will be transported, insert and tighten the two rack security screws (E).

Installing the cable-management arm
You might need to install the cable-management arm. Use the procedure in this section to perform this
task.

To install the cable-management arm, complete the following steps:
1. From the rear of the rack, locate the cable-management arm flange (A) located on the fixed rear

portion of the left system rail assembly (viewing from the back of the rack).
2. Attach the cable-management arm clasp (B) to the rail by pushing the clasp onto the rail until it locks

into place.

Figure 12. Rack latches and screws
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3. Attach the other end of the cable-management arm (C) to the rear of the HMC. Align the tabs (D) on
the cable-management arm with the slots (E) on the rear of the HMC.

4. Slide the cable-management arm to the left, securing it into place. Make sure all the tabs fit into the
slots.

5. Push the locking lever (F) into the locked position. Ensure that the cable-management arm (C) is level
so that it moves freely.

Cabling your rack-mounted HMC
Learn how to physically install your rack-mounted HMC.
1. Ensure that you position the HMC in the correct location.
2. Install the HMC into a rack. For more information, see “Installing the 7310-CR4 HMC into a rack”

on page 24. When you are finished installing the HMC into a rack, continue with the next step.
3. Plug the power cord into the HMC.
4. Connect the keyboard, monitor, and mouse.
5. Connect an optional modem:

If you are connecting an external modem, do the following:

Note: You can use other connectivity methods to send error information to IBM. For more
information, see “Deciding which connectivity method to use for the call-home server” on page 5.
a. If you want to install the external modem into a rack, do it now.
b. If you have not already done so, connect the modem data cable to the external HMC modem.
c. Connect the modem data cable to the system port on the HMC labeled with the following

symbol:

d. Use the telephone cable to connect the line port of the external modem to the analog telephone
jack on your wall.

e. Plug the modem power supply cord into the HMC modem.

Figure 13. Cable-management arm and system unit.
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If you are connecting to an integrated modem, use the data cable to connect the integrated HMC modem
to the appropriate data source. For example, use the telephone cable to connect the HMC modem
line port to the analog jack on your wall.

Note: You can use other connectivity methods to send error information to IBM. For more
information, see “Deciding which connectivity method to use for the call-home server” on page 5.

6. Connect the Ethernet (or crossover) cable from the HMC to the managed server:

Note: To learn more about the HMC network connections, see “HMC network connections” on page
3.

7. If your managed system is already installed, you can verify that the Ethernet cable connection is
active by observing the green status lights at both the HMC and managed system Ethernet ports as
your installation progresses.

8. Connect the Ethernet port on the HMC to the Ethernet port that is labeled HMC1 on the managed
server.

9. If you are connecting a second HMC to your managed server, connect to the Ethernet port that is
labeled HMC2 on the managed server.

10. Plug the power cords for the monitor, HMC, and HMC external modem into electrical outlets.

Note: If you are connecting this HMC to a new managed system, do not connect the managed
system to a power source at this time.

Next, you will need to configure your HMC software. Continue with “Configuring the HMC” on page
49.

Installing the 7042-CR5, 7042-CR6, and 7042-CR7 into a rack
This section describes how to install the 7042-CR5, 7042-CR6, and 7042-CR7 HMC into a rack.

If an HMC is used to manage any POWER7 processor-based system, the HMC must be a CR3, or later,
model rack-mounted HMC.

Complete a parts inventory. The following illustration shows the items that you need to install the server
in the rack cabinet. If any items are missing or damaged, contact your place of purchase.
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Note: Screws can be used for shipping, or for additional stabilization in high-vibration areas.

To install a 7042-CR5, 7042-CR6, or 7042-CR7 HMC into a rack, complete the following steps:
1. Each slide rail is marked with either an R (right) or an L (left). Select one of the slide rails and push

up on the front movable tab (1); then, pull out the front latch (2) to slide out the front side rail. If a
thumbscrew is installed in the slide rail (3), remove it.

Note: Make sure that the movable tab remains extended and does not click back into place.

Figure 14. Parts inventory

Figure 15. Slide rail and movable tab

36 Power Systems: Installing and configuring the Hardware Management Console



2. Align the three pins on the rear of the slide rail with the three holes in the selected U on the rear of
the rack. Push the rails so that the pins go into the holes (1), and drop the slide rail down (2) until it
latches into place.

3. Pull the slide rail forward and insert the two pins (1) on the front of the rail into the two lower holes
in the U on the front of the rack. Drop the rail into place until it clicks into place. Push the front
latch (2) in all the way. Repeat steps 1 through 3 to install the other rail into the rack. Make sure that
each front latch is fully seated.

4. Pull the slide rails forward (1) until they click, twice, into place. Carefully lift the server and tilt it
into position over the slide rails so that the rear nail heads (2) on the server line up with the rear
slots (3) on the slide rails. Slide the server down until the rear nail heads slip into the two rear slots,
and then slowly lower the front of the server (4) until the other nail heads slip into the other slots on
the slide rails. Make sure that the front latch (5) slides over the nail heads.

Figure 16. Align the pins with the holes in the rear of the rack

Figure 17. Rack front rail and pins
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5. Lift the blue release latches (1) on the slide rails and push the server (2) all the way into the rack
until it clicks into place.

6. The cable-management arm can be installed on either side of the server. The following figure shows
it being installed on the left side. To install the cable-management arm on the right side, follow the
instructions and install the hardware on the opposite side. Connect one end of the support arm (1) to
the same slide rail to which you plan to attach the cable-management arm so that you can swing the
other end of the support arm (2) toward the rack.

Figure 18. Slide rails extended, server nail heads aligned with slots in rail

Figure 19. Release latches and server
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7. Install the L-shaped cable-management stop bracket (1) on the unattached end of the support arm.
Turn the bracket (2) to secure it to the support arm.

8. To attach the other side of the support arm to the backside of the slide rail, pull the pin out (1), and
then slide the bracket (2) into the slide rail.

9. Pull out the mounting bracket pin (1) and slide the mounting bracket (2) into the slide rail onto
which you are installing the cable-management arm. Push the bracket into the slide rail until the

Figure 20. Support arm connection

Figure 21. Cable-management stop bracket secured to the support arm

Figure 22. Pin extended, bracket installed into slide rail
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spring-loaded pin snaps into place.

10. Place the cable-management arm on the support arm. Pull out the cable-management arm pin (1),
and then slide the cable-management arm tab (2) into the slot on the inside of the slide rail. Push the
tab until it snaps into place. Pull out the other cable-management arm pin (3), and then slide that
cable management arm tab into the slot (4) on the outside of the slide rail. Push the tab until it snaps
into place.

11. Attach the power cords and other cables to the rear of the server (including keyboard, monitor, and
mouse cables, if required). Route the cables and power cords on the cable-management arm (1) and
secure them with cable ties or hook-and-loop fasteners.

Note: Allow slack in all cables to avoid tension in the cables as the cable-management arm moves.

Figure 23. Mounting bracket pin extended and mounting bracket installed into slide rail

Figure 24. Cable-management arm connection
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12. Slide the server into the rack until it snaps into place.

Installing the monitor and keyboard
Learn how to install the monitor and keyboard, which are shipped with the 7042-CR6 HMC, into a rack.
This is a customer task.

If an HMC is used to manage a POWER7 processor-based system, the HMC must be at CR3, or later, it
must be a rack-mounted HMC model. The IBM eserver 7316-TF3 is a 17 inch, flat-panel, and
rack-mounted monitor and keyboard tray. A special keyboard, that is available for a variety of languages,
fits inside the front of the keyboard tray. The monitor and keyboard tray occupy 1 Electronics Industries
Association (EIA) unit 1 of space in a rack cabinet. You can install a console switch behind the tray to
attach more than one server to the flat panel monitor and keyboard.

To install the 7042-CR6 HMC into a rack, complete the following steps:

Attention: Installing the rails in the rack is a complex procedure. To install the rails correctly, you must
perform each task in the following order.
1. Complete a parts inventory. For instruction, see Completing a parts inventory.
2. Locate the rack-mounting hardware kit and the system rail assemblies that were included with your

system unit.

Figure 25. Power cord attachment and routing
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A One keyboard tray with built-in flat panel monitor

B Outer rails (2)

C Rail alignment spacer (1)

D Right-side console-switch mounting bracket (1)

E Left-side console-switch mounting bracket (1)

F Keyboard with built-in pointing device (1)

G Miscellaneous Hardware kit: 12 cage nuts, 12 clip nuts, 10 philips screws, 4 (8-32) screws, and 2 thumbscrews.

H 1.8 m (6 ft) power cord (1)

I 2.4 m (8 ft) International Electrotechnical Commission (IEC) connector power cable (1)

J Keyboard extension cable (1)

K Mouse extension cable (1)

L The CD containing Windows keyboard and mouse drivers (not for use with Eserver pSeries systems or any AIX,
Linux, or OS/400-based system)

Important: Use the following tools to install the flat panel rack-mounted monitor and keyboard:
v Scissors
v Philips screwdriver
v Flat-head screwdriver

Completing a parts inventory
You might need to complete a parts inventory.

If you have not done so, complete a parts inventory before proceeding with the installation:
1. Locate the kitting report in an accessory box.

Figure 26. Installation kit parts
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2. Ensure that you received all the parts that were ordered.

If there are incorrect, missing, or damaged parts, contact your IBM reseller or IBM sales and support.

Marking the location without using a rack-mounting template
You can mark the location without using a template.

A rack-mounting template is not included with this system. These systems are 1 EIA unit high.

To determine the mounting location, complete the following steps:
1. Determine to place the system in the rack. Record the EIA location.

Note: An EIA unit on your rack consists of a grouping of three holes.
2. Facing the front of the rack and working from the right side, place a supplied self-adhesive dot next

to the top hole of the EIA unit.

Note: The self-adhesive dots are used to aid in identifying locations on the rack. If you no longer
have any of the dots, use some other form of marking tool to aid you in identifying hole locations (for
example, tape, a marker, or pencil). If you are installing slide rails, place a mark or self-adhesive dot
on the lower and the middle hole of each EIA unit.

3. Place another self-adhesive dot next to the bottom hole of the above EIA unit.

Note: If you are counting the holes, begin with the hole identified by the first dot and count up two
holes. Place the second dot next to the third hole.

4. Repeat step 1 on page 27 for the corresponding holes located on the left side of the rack.
5. Go to the rear of the rack.
6. On the right side, find the EIA unit that corresponds to the bottom EIA unit marked on the front of

the rack.
7. Place a self-adhesive dot at the bottom EIA unit.
8. Place a self-adhesive dot at the top hole of the EIA unit.
9. Mark the corresponding holes on the left side of the rack.

Installing the monitor and keyboard into a rack
Learn how to install the monitor and keyboard that are shipped with the 7042-CR6 HMC into a rack.

The IBM 7316-TF3 17-inch, flat panel, rack-mounted, monitor and keyboard occupies 1.75 inches (1 EIA)
of rack-mounting space in a rack cabinet. You can use the brackets that are provided with this kit to
install an optional console switch in the same rack-mounting space as the monitor console kit.

To install the monitor and keyboard of the 7042-CR6 HMC into a rack, complete the following steps:

Attention: Remove the rack doors and side panels to provide easy access for installation.

Complete the following steps to install the monitor and keyboard into a rack:
1. Select a location in the rack for the monitor and keyboard tray. For more information, see Marking

the location.
2. Install 4 cage nuts (on square-holed rack flanges) or 4 clip nuts (round-holed rack flanges) in the

same EIA positions on the front and rear of the rack.

Note: If you plan to install the optional console switch, install a cage nut or clip nut in the
center-rear position as shown in the following illustration.
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3. Loosen the two rail-adjustment screws that are located on each of the outer slide rails. Extend the
rails to the maximum outward adjustment.

4. Adjust the outer slide-rail brackets to fit the depth of the rack cabinet. Then, attach the front of the
slide-rail brackets to fit the depth of the rack cabinet by using four screws from the miscellaneous
hardware kit. The screws should be finger-tight to allow adjustment of the rails.

Note: Ensure that the slide-rail brackets extend outside of the rack-cabinet mounting flanges. Do not
install screws in the middle holes on the front or rear of the slide-rail brackets. These holes will be
used to attach thumbscrews or optional console-switch mounting brackets, respectively, later in this
procedure.

5. Use the four screws from the miscellaneous hardware kit and finger-tight them from the rear of the
slide-rail brackets to the rack cabinet. Ensure that the slide-rail brackets extend outside of the
rack-cabinet mounting flanges.

6. Tighten the two rail-adjustment screws on each of the outer rails that you loosened in step 5

Figure 27. Installing the cage nuts

Figure 28. Adjusting the side-rail bracket
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7. Insert the rail-alignment spacer into the slide-rail middle holes. Ensure that the rail-alignment spacer
wraps around the rails. Tighten the front four screws and then, remove the spacer.

8. Extend the inner part of the rails mounted in the rack, and then, slide the ball-bearing assemblies
forward to the front of the rails.

9. Slide the flat-panel monitor and keyboard tray into the ball-bearing assemblies in the rails.

10. Press the release latches and push the flat-panel monitor and keyboard tray completely into the rack.
You may experience some resistance initially, as the ball-bearing assemblies align between the inner
and outer rails. Pull out the tray halfway, and then, push it back to seat the tray in the rails. Perform
this a few times to ensure that the tray moves smoothly in the rails.

Figure 29. Inserting the rail-adjustment spacer

Figure 30. Sliding the monitor and keyboard
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Note:
The video cable is connected to the flat-panel monitor. When you install the tray in the rack cabinet,
ensure that you do not pinch or cut the video cable.

11. Push the tray into the rack and tighten the four rear slide-rail bracket screws.
12. Place the keyboard on a stable flat surface and remove the two adhesive rubber pads located at each

end of the bottom of the new keyboard. Do not leave the rubber pads on the keyboard, because the
rubber pads might extend into the space below the tray.

Note:
Do not extend the keyboard feet. The flat-panel monitor screen might be damaged if the feet is
extended when the monitor is closed.

13. Pull the tray out of the rack until it is extended fully on the rails.
14. Lift the front of the flat-panel monitor, then raise the monitor to the full upright position.

15. Insert the keyboard into the tray. Then, route the keyboard-and-mouse cable through the cord clip on
the bottom of the tray, up through the opening on the right side of the tray, and toward the
cable-management arm. Pull out the full length of the cable through the opening.

16. Place the keyboard and mouse cables on the tray behind the monitor. Ensure that the cables do not
obstruct devices in the rack when the tray is pushed into its position. In the following steps, you will
route the cables through the cable-management arm.

17. Lower the monitor to the down position and then push the tray all the way into the rack. Use the
thumbscrews to secure the front of the tray into the rack.

18. From the rear of the rack, remove the shipping straps that holds the cable-management arm into the
tray.

19. Route the keyboard and mouse cables through the cable-management arm. Use the existing cable
straps to secure the cables.

Figure 31. Using the release latch

Figure 32. Raising the monitor to the full upright position
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20. Remove the rail-adjustment screw that is located closest to the rear of the rack from the left-slide rail.
Use a screw to attach the cable-management arm to the rail.

21. Connect the video, keyboard, and mouse connectors to either a server or optional console switch in
the rack cabinet. If you are installing the optional console switch, see Installing the Optional Console
Switch and complete the steps described. If not, follow the procedure from Step 21 to complete the
installation of your monitor and keyboard tray.

22. Connect the power cord to the short jumper cord on the cable-management arm.
23. Connect all cables and signal connectors to the correct device or connector.
24. Ensure that all power switches are turned off. Connect the power cord to a grounded electrical outlet

or power distribution unit (PDU).

Note: Ensure that the voltage of the local electrical supply is in the range 100 - 240 volt ac, before
you connect the ac power cord to the dc adapter outlet.

25. Extend the tray from the front of the rack cabinet. Route cables within the rack cabinet, and secure
them with cable straps.

Installing the console switch (optional)
Learn how to install the optional console switch.

Figure 33. Attaching the cable-management arm
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You can use the console switch to connect more than one server to a single monitor and keyboard. The
console switch option is available separately, but custom mounting brackets for the switch are available
with the installation kit.

By installing the console switch behind the monitor and keyboard tray, both the monitor and keyboard
tray can occupy the same space in the rack. To install the console switch behind the tray, use the brackets
provided with the installation kit.

Complete the following steps to install the console switch behind the tray:
1. Use two 8-32 screws to attach the right and left side brackets to the right-side and left-side of the

console switch respectively.

Note: The left-side bracket has a channel to route the power, video, keyboard, and mouse cables.
Ensure that you attach the brackets to the console switch so that the channel on the left-side bracket
faces upward.

2. Install the console switch behind the flat panel monitor and keyboard tray by using four (two on each
side) philips screws supplied in your miscellaneous hardware kit.

3. Route the power, video, keyboard, and mouse cables through the channel in the left-side bracket on
the console switch. Then, connect the video, keyboard, and mouse connectors to the console switch.

Figure 34. Installing the console switch
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4. Connect the power cords, routing cables, and cable straps. For instruction, see Connect the power
cord to the short jumper cord on the cable-management arm.

Configuring the HMC
Configure network connections, security, service applications, and some user preferences.

Depending on the level of customization you intend to apply to your HMC configuration, you have
several options for setting up your HMC to suit your needs. The ������������������������������ is a
tool on the HMC designed to ease the setup of the HMC. You can choose a fast path through the wizard
to quickly create the recommended HMC environment, or you can choose to fully explore the available
settings that the wizard guides you through. You can also perform the configuration steps without the
aid of the wizard by Configuring the HMC using the HMC menus.

Before you start, gather the required configuration information that you will need to complete the steps
successfully. See “Preparing for HMC configuration” on page 16 for a list of the required information.
When you are finished preparing, ensure that you complete the “Preinstallation configuration worksheet
for the HMC” on page 16 and then return to this section.

Configuring the HMC by using the fast path through the Guided Setup
wizard
In most cases, the HMC can be set up to operate effectively using many of the default settings. Use this
fast path checklist to prepare the HMC for service. When you have completed these steps, your HMC
will be configured as a Dynamic Host Configuration Protocol (DHCP) server in a private (directly
connected) network.

Configuring the HMC by using the HMC menus
This section provides a complete list of all HMC configuration tasks, guiding you through the process of
configuring your HMC. Choose this option if you prefer not to use the ������������������������������.

Figure 35. Routing cables
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You must restart your HMC for the configuration settings to take effect, so you might want to print this
checklist and keep it with you as you configure your HMC.

Prerequisites

Before you begin configuring the HMC using the HMC menus, be sure to complete the configuration
preparation activity described in “Preparing for HMC configuration” on page 16.

Starting the HMC
You can long in to the HMC and choose which language you want to be displayed in the interface. Use
the default User ID hscroot and password abc123 to log on to the HMC for the first time.

To start the HMC, do the following:
1. Turn on the HMC by pressing the power button.
2. If English is your language preference, continue with step 4.

If your language preference is a language other than English, type the number 2 when you are
prompted to change the locale.

Note: This prompt times out in 30 seconds if you do not act.
3. Select the locale that you want to display from the list in the Locale Selection window, and click OK.

The locale identifies the language that the HMC interface uses.
4. Click Log on and launch the Hardware Management Console web application.
5. Log in to the HMC using the following default user ID and password:

ID: hscroot
Password: abc123

6. Press Enter.

Changing the date and time
The battery-operated clock keeps the date and time for the HMC. You might need to reset the console
date and time if the battery is replaced, or if you physically move your system to a different time zone.
Learn how to change the date and time for the HMC.

If you change the date and time information, the change does not affect the systems and logical partitions
that the HMC manages.

To change the date and time for the HMC, do the following:
1. Ensure that you are a member of one of the following roles:
v Super administrator
v Service representative
v Operator
v Viewer

2. In the navigation area, click HMC Management.
3. In the content pane, click Change Date and Time.
4. If you select UTC in the Clock field, the time setting will adjust automatically for daylight saving

time in the time zone you select. Enter the date, time, and time zone, and click OK.

Configuring the HMC network types
Configure your HMC so that it can communicate to the managed system, logical partitions, remote users,
and service and support.
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Configuring HMC settings to use an open network to connect to the managed system:

Configure the HMC so that it can connect to and manage a managed system using an open network.

To configure the HMC network settings so that it can connect to the managed system using an open
network, do the following:

Table 7. Configuring HMC settings to use an open network to connect to the managed system

Task Where to find related information

1. Decide which interface you want to use for your
managed system. eth0 is preferred.

“Preinstallation configuration worksheet for the HMC”
on page 16

2. Identify the Ethernet ports for your HMC. “Identifying the Ethernet port defined as eth0” on page
53

3. Configure the Ethernet adapter by performing the
following tasks:

a. Set the media speed. “Setting the media speed” on page 54

b. Select the open network type. “Selecting a private or open network” on page 54

c. Set static addresses. “Setting the IPv4 address” on page 55

d. Set the firewall. “Changing HMC firewall settings” on page 56

e. Configure the default gateway. “Configuring a routing entry as the default gateway” on
page 57

f. Configure DNS. “Configuring domain name services” on page 57

4. Configure additional adapters, if you have them.

5. Test the connection between the managed server and
the HMC.

“Testing the connection between the HMC and the
managed system” on page 64

Configuring HMC settings to use a private network to connect to the managed system:

Configure the HMC so that it can connect to and manage a managed system using a private network.

To configure the HMC network settings so that it can connect to the managed system using a private
network, do the following:

Table 8. Configuring HMC settings to use a private network to connect to the managed system

Task Where to find related information

1. Decide which interface you want to use for your
managed system.

“Preinstallation configuration worksheet for the HMC”
on page 16

2. Identify the Ethernet ports for your HMC. “Identifying the Ethernet port defined as eth0” on page
53

3. Configure the HMC as a DHCP server. “Configuring the HMC as a DHCP server” on page 55

4. Test the connection between the managed server and
the HMC.

“Testing the connection between the HMC and the
managed system” on page 64

Configuring HMC settings to use an open network to connect to logical partitions:
To configure the HMC network settings so that it can connect to logical partitions using an open network,
do the following:
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Table 9. Configuring HMC settings to use an open network to connect to logical partitions

Task Where to find related information

1. Decide which interface you want to use for your
managed system.

“Preinstallation configuration worksheet for the HMC”
on page 16

2. Identify the Ethernet ports for your HMC. “Identifying the Ethernet port defined as eth0” on page
53

3. Configure the Ethernet adapter by performing the
following tasks:

a. Set the media speed. “Setting the media speed” on page 54

b. Select the open network type. “Selecting a private or open network” on page 54

c. Set static addresses. “Setting the IPv4 address” on page 55

d. Set the firewall. “Changing HMC firewall settings” on page 56

e. Configure the default gateway. “Configuring a routing entry as the default gateway” on
page 57

f. Configure DNS. “Configuring domain name services” on page 57

4. Configure additional adapters, if you have them.

5. Test the connection between the managed server and
the HMC.

“Testing the connection between the HMC and the
managed system” on page 64

Configuring HMC settings to use an open network to connect to remote users:
To configure the HMC network settings so that it can connect to remote users using an open network, do
the following:

Table 10. Configuring HMC settings to use an open network to connect to remote users

Task Where to find related information

1. Decide which interface you want to use for your
managed system.

“Preinstallation configuration worksheet for the HMC”
on page 16

2. Identify the Ethernet ports for your HMC. “Identifying the Ethernet port defined as eth0” on page
53

3. Configure the Ethernet adapter by performing the
following tasks:

a. Set the media speed. “Setting the media speed” on page 54

b. Select the open network type. “Selecting a private or open network” on page 54

c. Set static addresses. “Setting the IPv4 address” on page 55

d. Set the firewall. “Changing HMC firewall settings” on page 56

e. Configure the default gateway. “Configuring a routing entry as the default gateway” on
page 57

f. Configure DNS. “Configuring domain name services” on page 57

g. Configure suffixes. “Configuring domain suffixes” on page 57

4. Configure additional adapters, if you have them.

Configuring HMC call-home server settings:
To configure the HMC call-home server settings so that problems can be reported, do the following:
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Table 11. Configuring HMC call-home server settings

Task Where to find related information

1. Be sure you have all the required customer
information

“Preinstallation configuration worksheet for the HMC”
on page 16

2. Configure this HMC to report errors or choose an
existing call-home server to report errors

“Configuring the local console to report errors to service
and support” on page 59

“Choosing existing call-home servers to connect to
service and support for this HMC” on page 62

3. Verify that your call-home configuration is working “Verifying that your connection to service and support is
working” on page 62

4. Authorize users to view collected system data “Authorizing users to view collected system data” on
page 63

5. Schedule transmission of system data “Transmitting service information” on page 63

Identifying the Ethernet port defined as eth0:

Your Ethernet connection to the managed server must be made using the Ethernet port that is defined as
eth0 on your HMC.

If you have not installed any additional Ethernet adapters in the PCI slots on your HMC, the primary
integrated Ethernet port is always defined as eth0 or eth1 on your HMC, if you intend to use the HMC
as a DHCP server for your managed systems.

If you have installed additional Ethernet adapters in the PCI slots, the port that is defined as eth0
depends on the location and type of Ethernet adapters you have installed.

Note: These are general rules and may not apply for all configurations.

The following table describes the rules for Ethernet placement by HMC type.

Table 12. HMC types and associated rules for Ethernet placement

HMC type Rules for Ethernet placement

Rack-mounted HMCs with two integrated Ethernet ports The HMC supports only one additional Ethernet adapter.

v If an additional Ethernet adapter is installed, that port
is defined as eth0. In this case, the primary integrated
Ethernet port is then defined as eth1, and the
secondary integrated Ethernet port is defined as eth2.

v If the Ethernet adapter is a dual port Ethernet adapter
then port labeled Act/Link A will normally be eth0.
The port labeled Act/link B would be eth1. In this
case, the primary integrated Ethernet port is then
defined as eth2, and the secondary integrated Ethernet
port is defined as eth3.

v If no adapters are installed, the primary integrated
Ethernet port is defined as eth0.
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Table 12. HMC types and associated rules for Ethernet placement (continued)

HMC type Rules for Ethernet placement

Stand-alone models with a single integrated Ethernet
port

The definitions depend upon the type of Ethernet
adapter you have installed:

v If only one Ethernet adapter is installed, that adapter
is defined as eth0.

v If the Ethernet adapter is a dual port Ethernet adapter,
then the port labeled Act/link A will be eth0. The port
labeled Act/link B would be eth1. In this case, the
primary integrated Ethernet port is then defined as
eth2.

v If no adapters are installed, the integrated Ethernet
port is defined as eth0.

v If multiple Ethernet adapters have been installed, see
“Determining the interface name for an Ethernet
adapter.”

Determining the interface name for an Ethernet adapter:

If you configure the HMC as a DHCP server, that server can operate only on the network interface card
(NIC) connectors that the HMC identifies as eth0 and eth1. You might also need to determine which NIC
connector you need to plug the Ethernet cable into. Learn more about determining which NIC connectors
the HMC identifies as eth0 and eth1.

To determine the name the HMC has assigned to an Ethernet adapter, do the following:
1. Open the restricted shell terminal. Select HMC Management > Open Restricted Shell Terminal.
2. Type the following at the command line: tail -f /var/log/messages. The messages log scrolls when

new events occur.
3. Plug in your Ethernet cable. If the cable was already plugged in, then unplug it, wait 5 seconds, and

plug in the cable again. The restricted shell scrolls to display a message when you plug-in the cable.
The following example entry shows that this Ethernet port is identified as eth0: Aug 28 12:41:20
termite kernel: e1000: eth0: e1000_watchdog: NIC Link is Up 100.

4. Repeat this procedure for all other Ethernet ports, and record your results.
5. Type Ctrl+C to stop the tail command.

Setting the media speed:

Learn how to specify the media speed which includes the speed and duplex mode of the Ethernet
adapter.
1. In the navigation area, click HMC Management.
2. Click Change network settings.
3. Click the LAN Adapters tab.
4. Select the LAN adapter you want to work with and click Details.
5. In the Local area network information section, select Autodetection or the appropriate media speed

and duplex combination.
6. Click OK.

Selecting a private or open network:

A private service network consists of the HMC and the managed systems. A private service network is
restricted to consoles and the systems they manage, and is separate from your company network. An
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open network consists of your private service network and your company network. An open network
might contain network endpoints in addition to consoles and managed systems, and might span across
multiple subnets and network devices.

To select a private or public network, do the following:
1. In the navigation area, click HMC Management.
2. Click Change network settings.
3. Click the LAN Adapters tab.
4. Select the LAN adapter that you want to work with and click Details.
5. Click the Lan Adapter tab.
6. In the Local area network information page, select Private or Open.
7. Click OK.

Configuring the HMC as a DHCP server:

Dynamic Host Configuration Protocol (DHCP) provides an automated method for dynamic client
configuration.

To configure the HMC as a DHCP server, do the following:
1. In the navigation area, click HMC Management.
2. In the Work area, click Change network settings. The Customize Network Settings window opens.
3. Select the LAN adapter that you want to work with and click Details.
4. Select Private and then select the network type.
5. In the DHCP Server section, select Enable DHCP Server to enable the HMC as a DHCP server.

Note: You can configure the HMC to be a DHCP server only on a private network. If you use an
open network, you do not have the option to select the Enable DHCP.

6. Enter the address range of the DHCP server.
7. Click OK.

If you configured your HMC to be a DHCP server on a private network, you must verify that your HMC
DHCP private network is configured correctly. For information about connecting your HMC to a private
network, see “Selecting a private or open network” on page 54.

For more information, see “HMC as a DHCP server” on page 5.

Setting the IPv4 address:

Learn how to set your IPv4 address on the HMC.
1. In the navigation area, click HMC Management.
2. Click Change network settings.
3. Click the LAN Adapters tab.
4. Select the LAN adapter that you want to work with and click Details.
5. Click the Basic Settings tab.
6. Select an IPv4 address.
7. If you selected to specify an IP address, enter the TCP/IP interface address and the TCP/IP interface

network mask.
8. Click OK.
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Setting the IPv6 address:

Learn how to set your IPv6 address on the HMC.
1. In the navigation area, click HMC Management.
2. Click Change network settings.
3. Click the LAN Adapters tab.
4. Select the LAN adapter that you want to work with and click Details.
5. Click the IPv6 Settings tab.
6. Select an Autoconfig option or add a static IP address.
7. If you added an IP address, enter the IPv6 address and the prefix length and click OK.
8. Click OK.

Using only IPv6 addresses:

Learn how to configure the HMC so that it uses only IPv6 addresses.
1. In the navigation area, click HMC Management.
2. Click Change network settings.
3. Click the LAN Adapters tab.
4. Select the LAN adapter that you want to work with and click Details.
5. Select No IPv4 address.
6. Click the IPv6 Settings tab.
7. Select Use DHCPv6 to configure IP settings or add static IP addresses. Then click OK.

After you click OK, you must reboot your HMC for these changes to take effect.

Changing HMC firewall settings
In an open network, a firewall is used to control outside access to your company network. The HMC also
has a firewall on each of its Ethernet adapters. To control the HMC remotely or give remote access to
others, modify the firewall settings of the Ethernet adapter on the HMC that is connected to your open
network.

To configure a firewall, use the following steps:
1. In the navigation area, click HMC Management.
2. Click Change network settings.
3. Click the LAN Adapters tab.
4. Select the LAN adapter that you want to work with and click Details.
5. Click the Firewall tab.
6. Using one of the following methods, you can allow any IP address using a particular applications

through the firewall, or you can specify one or more IP addresses:
v Allow any IP address using a particular application through the firewall:

a. From the top box, highlight the application.
b. Click Allow Incoming. The application displays in the bottom box to signify that it has been

selected.
v Specify which IP addresses to allow through the firewall:

a. From the top box, highlight an application.
b. Click Allow Incoming by IP Address.
c. On the Hosts Allowed window, enter the IP address and the network mask.
d. Click Add and click OK.

7. Click OK.
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Enabling remote restricted shell access:

You can enable remote restricted shell access when configuring a firewall.

To enable remote restricted shell access, do the following:
1. In the navigation area, click HMC Management.
2. Click Remote Command Execution.
3. Select Enable remote command execution using the ssh facility and then click OK.

Now remote restricted shell access is enabled.

Enabling remote web access:

You can enable remote web access to your HMC.

To enable remote web access, do the following:
1. In the navigation area, click HMC Management.
2. Click Remote Operation.
3. Select Enable and then click OK.

Now remote web access is enabled.

Configuring a routing entry as the default gateway
Learn how to configure a routing entry as the default gateway. This task is available for those using an
open network.

To configure a routing entry as the default gateway, do the following:
1. In the Work area, click Change network settings. The Customize Network Settings window opens.
2. Click the Routing tab.
3. In the Default gateway information section, enter the gateway address and gateway device of the

routing entry you want to set as the default gateway.
4. Click OK.

Configuring domain name services
If you plan to set up an open network, configure domain name services.

Domain Name System (DNS) is a distributed database system for managing host names and their
associated Internet Protocol (IP) addresses. Configuring domain name services includes enabling DNS
and specifying the domain suffix search order.
1. In the work area, click Change network settings. The Change Network Settings window opens.
2. Click the Name Services tab.
3. select DNS enabled to enable DNS.
4. Specify the DNS server and domain suffix search order and click Add.
5. Click OK.

Configuring domain suffixes
The list of domain suffixes is used to resolve an IP address starting with the first entry in the list.

The domain suffix is a string appended to a host name that is used to help resolve its IP address. For
example, a host name of myname might not be resolved. However, if the string myloc.mycompany.com is an
element in the domain suffix table, then there will be an attempt to resolve myname.mloc.mycompany.com
also.

Installing and configuring the Hardware Management Console 57



To configure a domain suffix entry, use these steps:
1. In the navigation area, click HMC Management.
2. In the work area, click Change network settings. The Customize Network Settings window opens.
3. Click the Name Services tab.
4. Enter a string to be used as a domain suffix entry.
5. Click Add to add it to the list.

Configuring the HMC so that it uses LDAP remote authentication
You can configure your HMC so that it uses LDAP (Lightweight Directory Access Protocol) remote
authentication.

When a user logs in to the HMC, authentication is first performed against a local password file. If a local
password file is not found, the HMC can contact a remote LDAP server for authentication. You must
configure your HMC so that it uses LDAP remote authentication.

Note: Before you configure the HMC so that it uses LDAP authentication, you must ensure that a
working network connection exists between the HMC and the LDAP servers. For more information about
configuring HMC network connections, see “Configuring the HMC network types” on page 50.

To configure your HMC so that it uses LDAP authentication, do the following:
1. In the navigation area, click HMC Management.
2. In the content area, click LDAP Configuration. The LDAP Server Definition window opens.
3. Select Enable LDAP.
4. Define an LDAP server to use for authentication.
5. Define the LDAP attribute used to identify the user being authenticated. The default is uid, but you

can use your own attributes.
6. Define the distinguished name tree, also known as the search base, for the LDAP server.
7. Click OK.
8. If a user wants to use LDAP authentication, the user must configure his profile so that it uses LDAP

remote authentication instead of local authentication.

Configuring the HMC so that it uses Key Distribution Center servers for Kerberos
remote authentication
You can configure the HMC so that it uses Key Distribution Center (KDC) servers for Kerberos remote
authentication.

When a user logs in to the HMC, authentication is first performed against a local password file. If a local
password file is not found, the HMC can contact a remote Kerberos server for authentication. You must
configure your HMC so that it uses Kerberos remote authentication.

Note: Before you configure the HMC so that it uses KDC servers for Kerberos remote authentication, you
must ensure that a working network connection exists between the HMC and the KDC servers. For more
information about configuring HMC network connections, see “Configuring the HMC network types” on
page 50.

To configure the HMC so that it uses KDC servers for Kerberos remote authentication, do the following:
1. Enable the Network Time Protocol (NTP) service on the HMC and set the HMC and the KDC servers

to synchronize time with the same NTP server. To enable the NTP service on the HMC, do the
following:
a. In the navigation area, select HMC Management.
b. In the content area, select Change Date and Time.
c. Select the NTP Configuration tab.
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d. Select Enable NTP service on this HMC.
e. Click OK.

2. Configure each remote HMC user's profile so that it uses Kerberos remote authentication instead of
local authentication.

3. Optional: you can import a service-key file into this HMC. The service-key file contains the host
principal that identifies the HMC to the KDC server. Service-key files are also known as keytabs. To
import a service-key file into this HMC, do the following:
a. In the navigation area, select HMC Management.
b. In the content area, select Configure KDC. The Key Distribution Center Configuration window

opens.
c. Select Actions > Import Service Key. The Import Service Key window opens.
d. Type the location of the service key file.
e. Click OK.

4. Add a new KDC server to this HMC. To add a new KDC server to this HMC, do the following:
a. In the navigation area, select HMC Management.
b. In the content area, select Configure KDC. The Key Distribution Center Configuration window

opens.
c. Select Actions > Add KDC Server. The Import Service Key window opens.
d. Type the realm and the host name or IP address of the KDC server.
e. Click OK.

Configuring the HMC so that it can contact service and support
Configure your HMC so that it can notify you when problems occur.

Configuring the HMC so that it can connect to service and support using the call-home setup wizard:

Configure the HMC so that it is a call-home server using the call-home wizard.

This procedure describes how to configure the HMC as a call-home server using direct (LAN-based) and
indirect (SSL) connections to the Internet.

Before you begin this task, ensure that:
v The network administrator has verified that connectivity is allowed. For more information, see

“Preparing for HMC configuration” on page 16.
v If you are configuring Internet support through a proxy server, you must also have the following:

– The IP address and port of the proxy server
– The proxy authentication information

v The adapter designated as eth1 (the one that is designated as an open network) is used. For more
information, see “Choosing network settings on the HMC” on page 9.

v An Ethernet cable physically connects the HMC to the LAN.

To configure the HMC so that it is a call-home server using the call-home wizard, do the following:
1. In the navigation area, select Service Management.
2. In the content area, select Call-Home Setup Wizard. The Connectivity and Call-Home Servers wizard

opens. Follow the instructions in the wizard to configure call-home.

Configuring the local console to report errors to service and support:

Configure this HMC so that it can call-home errors using LAN connectivity, the phone or modems, or
VPN.
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Configuring an HMC to contact service and support using LAN-based Internet and SSL:

Describes how to configure the HMC as a call-home server using direct (LAN-based) and indirect (SSL)
connections to the Internet.

Before you begin this task, ensure that:
v The network administrator has verified that connectivity is allowed. For more information, see

“Preparing for HMC configuration” on page 16.
v Customer contact information has been configured. Verify this by going to the HMC interface and

clicking Service Management > Manage Customer Information.
v If you are configuring internet support through a proxy server, you must also have the following:

– The IP address and port of the proxy server
– The proxy authentication information

v You need at least one open network interface configured. For more information, see “Private and open
networks in the HMC environment” on page 5.

v An Ethernet cable physically connects the HMC to the LAN.

To configure the HMC as a Call-home server using LAN-based Internet and SSL, do the following:
1. In the Navigation area, click Service Management.
2. In the Connectivity section, click Manage Outbound Connectivity. The Call-home Server Consoles

window opens.
3. Click Configure...

4. In the Outbound Connectivity Settings window, check Enable local system as call-home server.
5. Accept the agreement.
6. In the Outbound Connectivity Settings window, select the Internet tab.
7. Check the Allow an existing internet connections for service box.
8. If you are using an SSL proxy, check the Use SSL proxy box.
9. If you are using an SSL proxy, fill in the proxy's address and port. Obtain this information from the

network administrator.
10. If you checked Use SSL proxy and the proxy requires user ID and password authentication, check

the Authenticate with the SSL proxy box. Type the userid and password. Obtain the user ID and
password from the network administrator.

11. Select the Protocol to Internet you want to use.
12. On the Internet tab, click Test....
13. In the Test Internet window, click Start.
14. Verify that the test completes successfully.
15. In the Test Internet window, click Cancel.
16. In the Outbound Connectivity Settings window, click OK.

Connecting to service and support using the telephone and modems:

Describes how to configure the HMC as a call-home server using modem access to IBM support.

Before you begin this task, ensure that:
v You have an dedicated analog telephone line available.
v You have the information required to configure the modem. For more information, see “Preparing for

HMC configuration” on page 16.
v Customer contact information has been configured. You may verify this by going to the HMC interface

and clicking Service Management > Manage Customer Information.
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v Ensure you have the following information available:
– The type of analog line; that is, tone or pulse. Most lines are tone, but some are in use that are the

older rotary or pulse type.
– Whether the line presents a dial tone when the telephone is picked up. Most telephones do, but

some are in use that do not.
– Whether a dial prefix string is required. A dial prefix string is a number or series of numbers that

allow access to an outside line.

To configure the HMC as a call-home server using modem access to IBM support, do the following:
1. In the navigation area, click Service Management.
2. In the Connectivity section, click Manage Outbound Connectivity.
3. Click Configure

4. In the Outbound Connectivity Settings window, select Enable local system as call-home server.
5. Accept the agreement.
6. In the Outbound Connectivity Settings window, click the Local Modem tab.
7. On the Local Modem page, select the Allow local modem dial for service checkbox.
8. On the Local Modem page, select the Modem Configuration checkbox.
9. In the Customize Modem Settings window, click Dial type, Tone or Pulse. If the line presents a dial

tone when the receiver is taken off the hook, select the Wait for dial tone checkbox. Fill in any dial
prefix string that is required to obtain an outside line.

10. Click OK.
11. On the Local Modem page, click Add.
12. Select a number from the list.
13. If this is a local number, remove the area code from the Telephone number field.
14. In the Add Telephone Number panel, click Add.
15. In the In the Customize Modem Settings panel, click Test.
16. In the Test Telephone Number panel, click Start.
17. Verify that the test completes successfully.
18. In the Test Telephone Number window, click Cancel.
19. You can configure up to five telephone numbers. Configure at least two telephone numbers (a

primary and a backup). The numbers will be attempted in the order that they are configured. To add
additional numbers to the callable list, repeat the steps in this procedure.

20. In the Outbound Connectivity Settings window, click OK.

Connecting to service and support using a LAN-based VPN:

Configure the call-home server using VPN.

Before you begin this task, ensure that:
v The network administrator has verified that connectivity is allowed. For more information, see

“Preparing for HMC configuration” on page 16.
v The adapter designated as eth1 (the one that is designated as an open network) is used. For more

information, see “Choosing network settings on the HMC” on page 9.
v An Ethernet cable physically connects the HMC to the LAN.
v Customer contact information has been configured. Verify this situation by clicking Service

Management > Manage Customer Information on the HMC interface.

To configure the call-home server using VPN, do the following:
1. In the navigation area, click Service Management.
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2. In the Connectivity section, click Manage Outbound Connectivity.
3. Click Configure

4. In the Outbound Connectivity Settings window, select Enable local system as call-home server.
5. Accept the agreement.
6. In the Outbound Connectivity Settings window, click the Internet VPN tab.
7. On the Internet VPN page, select the Allow A VPN and an existing Internet connections for service

.
8. On the Internet VPN page, click Test checkbox.
9. In the Test Internet VPN window, click Start.

10. Verify that the test completes successfully.
11. In the Test Internet VPN window, click Cancel.
12. In the Outbound Connectivity Settings window, click OK.

Choosing existing call-home servers to connect to service and support for this HMC:

Choose existing HMC call-home servers that have been recognized, or "discovered" by this HMC to
report errors.

Discovered HMCs are HMCs that are enabled as call-home servers and are either on the same subnet or
manage the same managed system as this HMC.

To choose a discovered HMC to call home when this HMC reports errors, do the following:
1. In the navigation area, click Service Management.
2. In the content area, click Manage Outbound Connectivity. The Call-Home Server Consoles window

opens.
3. Click the Use discovered call-home server consoles . The HMC displays the IP address or host name

of the HMCs configured for call-home.
4. Click OK.

Note: The HMC below 7.1.0 version should not be added as a call home proxy server in an HMC with or
above 7.1.0 version.

You can also manually add existing HMC call-home servers that are on a different subnet. Select the IP
address or host name of the HMC that is configured for call home and click Add. Then click OK.

Verifying that your connection to service and support is working:

Test problem reporting to ensure that connection to service and support is working.

To verify that your call-home configuration is working, do the following:
1. In the navigation area, click Service Management.
2. In the Work area, click Create Event.
3. select Test Automatic problem Reporting and type a comment.
4. Click Request Service. Wait a few minutes for the request to be sent.
5. In the Service Management window, select Manage Events.
6. Select All open problems.
7. Verify that there is a PMH event and number assigned to the problem number you opened.
8. select that event and select Close.
9. On the Close window, type your name and a brief comment.
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Authorizing users to view collected system data:

You must authorize users to view data about your systems.

Before you authorize users to view collected system data, you must obtain an IBM ID. For more
information about obtaining an IBM ID, see “Preinstallation configuration worksheet for the HMC” on
page 16.

To authorize users to view collected system data, do the following:
1. In the navigation area, select Service Management.
2. In the content area, select Authorize User.
3. Enter your IBM ID.
4. Click OK.

Transmitting service information:

You can transmit information to your service provider immediately, or you can schedule the information
to be sent on a regular basis.

IBM provides personalized Web functions that use information collected by IBM Electronic Service Agent.
To use these functions, you must first register on the IBM Registration website at http://www.ibm.com/
account/profile. To authorize users to use the Electronic Service Agent information to personalize the
Web functions, see “Authorizing users to view collected system data.” For more information about the
benefits of registering an IBM ID with your systems, see http://www.ibm.com/support/electronic.

Note: You should transmit service provider information as soon as the HMC is installed and configured
for use.

To transmit service information, do the following:
1. In the navigation area, click Service Management.
2. In the content area, click Transmit Service Information.

3. Complete the tasks in the Transmit Service Information window, and click OK.

Setting passwords for the managed system
You must set passwords for both your server and Advanced System Management (ASM). Read more
about how to use the HMC interface to set these passwords.

If you received the message Authentication Pending, the HMC prompts you to set the passwords for the
managed system.

If you did not receive the message Authentication Pending, complete the following steps to set the
passwords for the managed system.

Updating your server password:
To update your server password, do the following:
1. In the navigation area, select the managed system.
2. In the Tasks area, click Operations.
3. Click Change Password. The Update Password window opens.
4. Type the required information and click OK.

Updating your Advanced System Management (ASM) general password:

Note: The default password for the general user ID is general, and the default password for the
administrator ID is admin.
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To update your ASM general password, do the following:
1. In the navigation area of the HMC, select the managed system.
2. In the Tasks area, click Operations.
3. Click Advanced System Management (ASM). The Launch ASM Interface window opens.
4. Select a Service Processor IP Address and click OK. The ASM interface opens.
5. On the ASMI Welcome pane, specify your user ID and password, and click Log In.
6. In the navigation area, expand Login Profile.
7. Select Change Password.
8. Specify the required information, and click Continue.

Resetting the Advanced System Management (ASM) administrator password:
To reset the administrator password, contact an authorized service provider.

Testing the connection between the HMC and the managed system
This option enables you to verify that you are properly connected to the network.

To test network connectivity, you must be a member of one of the following roles:
v Super administrator
v Service representative

To test the connection between the HMC and the managed system, do the following:
1. In the navigation area, click HMC Management.
2. Click Test Network Connectivity.
3. In the Ping tab, type the host name or IP address of any system to which you want to connect. To test

an open network, type the gateway. Click Ping.

If you have not yet created any logical partitions, you will not be able to ping the addresses. You can use
the HMC to create logical partitions on your server. ���������������� PDF ���
�������������������������� ���������������� 1 MB ��������� http://publib.boulder.ibm.com/
infocenter/systems/scope/hw/topic/p7hat/p7hat.pdf.

To understand how the HMC can be used in a network, see “HMC network connections” on page 3.

For more information about configuring the HMC to connect to a network, see “Configuring the HMC by
using the HMC menus” on page 49.

Postconfiguration steps
After you have installed and configured the HMC, back up HMC data as necessary.

Backing up critical HMC data
You can back up important console information to a USB Flash Memory Device, DVD, via FTP, or over
the network.

Using the HMC, you can back up all important data, such as the following:
v User-preference files
v User information
v HMC platform-configuration files
v HMC log files
v HMC updates through Install Corrective Service
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The Backup function saves the HMC data stored on the HMC hard disk to the following:
v DVD media
v USB Flash Memory Device
v Remote system mounted to the HMC file system (such as NFS)
v Remote site through FTP

Back up the HMC after you have made changes to the HMC or to the information associated with logical
partitions.

Note: Before data can be saved to removable media, the media must be formatted. To format media, click
HMC Management > Format Media and follow the steps.

To back up the HMC, you must be a member of one of the following roles:
v Super administrator
v Operator
v Service representative

To back up the HMC critical data, do the following:
1. In the navigation area, click HMC Management.
2. Select Back up HMC Data.
3. Select an archive option. You can back up to media on the local system, back up to a mounted remote

system, or send backup data to a remote site.
4. Follow the instructions on the window to back up the data.

Backing up the entire HMC hard disk drive to a remote system
You can use your HMC to back up the entire hard disk drive of your HMC to a remote system.

Your remote system must have Network File System (NFS) or Secure Shell (ssh) configured, and this
network must be accessible from the HMC. To complete this task, you must shut down and reboot the
HMC. Use only the HMC to perform these tasks.

To back up the HMC hard disk drive to a remote system, you must be a member of one of the following
roles:
v Super administrator
v Operator
v Service representative

To back up the HMC hard drive to a remote system, do the following:
1. Record the interface number (eth0, eth1, etc), MAC address and IP address of each of the network

adapters on the HMC. To do this, click HMC Management > Change Network Settings > LAN
Adapters.

2. Shut down and power off the HMC.
3. Power on the HMC console with the HMC recovery media in the DVD drive. If you want to start

the HMC interface from a configured network boot server, make sure the network interface is one of
the devices in your startup sequence. To view the list of startup devices, press F12 when the HMC
powers on, and select the network interface from which you want to boot.

4. Select the backup option and click Next.
5. Select the network interface to use for communicating with the remote server. If you are starting the

HMC by contacting a network boot server, and this server is also the remote server to which you
want to back up the data, then select the default settings. Then click Next and go to step 7. If you do
not select the default settings, continue with the next step.
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Note: The interface numbering (eth0, eth1) may not match the numbering recorded in Step 1. The
MAC address listed can be used to identify the desired interface. For more information, see
“Identifying the Ethernet port defined as eth0” on page 53.

6. If you do not select the Default settings, you must select the network Protocol to use with the
selected interface. You can choose to obtain an IP address from a DHCP server in your network or
assign a static IP address to the selected network interface. Make your selection and click Next.

7. If you did not select the default settings, type the IP address or host name of your remote server.
The backup file will be created using the gzip compression utility and the tar command. Specify a
file with the .tgz extension in the File on remote host field. If you have selected the default network
settings, you must use the directory setup in your network boot configuration. This information is
displayed in the File on remote host field. After you have completed all the required information,
click Next.

8. Select the method you want to use to transfer the data from your HMC to the remote server. If you
choose to encrypt the data, your remote host must have Secure Shell (SSH) server running. If you
choose to transfer the data without encryption, your remote host must have Network File Server
(NFS) running, and the directory to which you want to back up data must be exported for write
access. Make your selection and click Next.

9. If you select to transfer the data using encryption, you must type the remote server's user ID and
password.

10. Verify the information you entered is correct and click Finish. When the backup completes, the HMC
interface is displayed.

If you have modified the startup sequence by pressing F1 when you powered on the HMC, you must
reboot the HMC and change the settings again. When you change the startup sequence, ensure that your
hard disk is listed in the startup sequence before the network interface.

Updating, upgrading, and migrating your HMC machine code
Updates and upgrades are periodically released for the HMC to add new functionality and to improve
existing features. Learn more about the differences between updating, upgrading, and migrating your
HMC machine code. Also learn how to perform an HMC machine code update, upgrade, or migration.

When you are finished with each of these tasks, the HMC reboots but the partitions do not.

Updating HMC code
Applies maintenance to an existing HMC level

Does not require that you perform the Save upgrade data task

Upgrading HMC code
Replaces HMC software with a new release or fix level of the same program

Requires that you boot from recovery media

Migrating HMC code
Moves HMC data from one HMC version to another

A migration is a type of upgrade.

Determining your HMC machine code version and release
Find out how to view the HMC machine code version and release.

The level of machine code on the HMC will determine the available features, including concurrent server
firmware maintenance and enhancements to upgrading to a new release.

To view the HMC machine code version and release, do the following:
1. In the navigation area, click Updates.

66 Power Systems: Installing and configuring the Hardware Management Console



2. In the Work area, view and record the information that appears under the HMC Code Level heading,
including: the HMC version, release, maintenance level, build level, and base versions.

Obtaining and applying machine code updates for the HMC with an
Internet connection
Learn how to obtain machine code updates for the HMC when the HMC has an Internet connection.

To obtain machine code updates for the HMC, perform steps 1 through 5.

Step 1. Ensure that you have an Internet connection
To download updates from the service and support system or website to your HMC or server, you must
have one of the following:
v SSL connectivity with or without a SSL proxy
v Internet VPN

To ensure that you have an Internet connection, do the following:
1. In the navigation area, click Service Management.
2. Select Manage Outbound Connectivity.
3. Select the tab for the type of outbound connectivity that you chose for your HMC (Internet VPN or

SSL connectivity).

Note: If a connection to service and support does not exist, set up the service connection before
proceeding with this procedure. For instructions on how to set up a connection to service and
support, see Setting up your server to connect to IBM service and support.

4. Click Test.
5. Verify that the test completes successfully. If the test is not successful, troubleshoot your connectivity

and correct the problem before proceeding with this procedure. Alternatively, you can obtain the
update on DVD.

6. Continue with “Step 2. View the existing HMC machine code level.”

Step 2. View the existing HMC machine code level
To view the existing HMC machine code level, do the following:
1. In the navigation area, click Updates.
2. In the Work area, view and record the information that appears under the HMC Code Level heading,

including the HMC version, release, maintenance level, build level, and base versions.
3. Continue with “Step 3. View the available HMC machine code levels.”

Step 3. View the available HMC machine code levels
To view the available HMC machine code levels, do the following:
1. From a computer or server with an Internet connection, go to http://www.ibm.com/eserver/

support/fixes.
2. Select the appropriate family in the Product family list.
3. Select Hardware Management Console in the Product or fix type list.
4. Click Continue. The Hardware Management Console site is displayed.
5. Scroll down to your HMC Version level to view available HMC levels.

Note: If you prefer, you can contact service and support.
6. Continue with “Step 4. Apply the HMC machine code update.”

Step 4. Apply the HMC machine code update
To apply the HMC machine code update, do the following:
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1. Before you install updates to the HMC machine code, back up critical console information on your
HMC. For instructions, see “Backing up critical HMC data” on page 64. Then continue with the next
step.

2. In the navigation area, click Updates.
3. Click Update HMC. The Install Corrective Service Wizard opens.
4. Follow the instructions in the Wizard to install the update.
5. Shut down and then restart the HMC for the update to take effect.
6. Click Log on and launch the Hardware Management Console web application.
7. Log in to the HMC interface.

Step 5. Verify that the HMC machine code update installed successfully
To verify that the HMC machine code update installed correctly, do the following:
1. In the navigation area, click Updates.
2. In the Work area, the HMC version, release, maintenance level, build level, and base versions are

displayed under the HMC Code Level heading.
3. Verify that the version and release match the update that you installed.
4. If the level of code displayed is not the level that you installed, perform the following steps:

a. select the network connection on the HMC.
b. Retry the firmware update using a different repository.
c. If the problem persists, contact your next level of support.

Obtaining and applying machine code updates for the HMC using DVD
or an FTP server
Learn how to obtain machine code updates for the HMC using DVD or an FTP server.

To obtain HMC machine code updates, perform steps 1-5.

Step 1. View the existing HMC machine code level
To view the existing HMC machine code level, do the following:
1. In the navigation area, click Updates.
2. In the Work area, view and record the information that appears under the HMC Code Level heading,

including the HMC version, release, maintenance level, build level, and base versions.
3. Continue with “Step 2. View the available HMC machine code levels.”

Step 2. View the available HMC machine code levels
To view the available HMC machine code levels, do the following:
1. From a computer or server with an Internet connection, go to the Hardware Management Console

Web site at http://www-933.ibm.com/support/fixcentral/.
2. Scroll down to your HMC Version level to view available HMC levels.

Note: If you prefer, you can contact IBM service and support.
3. Continue with “Step 3. Obtain the HMC machine code update.”

Step 3. Obtain the HMC machine code update
To obtain the HMC machine code update, do the following:

You can order the HMC machine code update through the Fix Central website, contact service and
support, or download it to an FTP server.

Ordering the HMC machine code update through the Fix Central Web site
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1. From a computer or server with an Internet connection, go to the Hardware Management
Console website at http://www-933.ibm.com/support/fixcentral/

2. Under Supported HMC products, select the latest HMC level.
3. Scroll down to the File name(s) / Package area and locate the update you want to order.
4. In the Order column, select Go.
5. Click Continue to sign in with your IBM ID.
6. Follow the on-screen prompts to submit your order.

Downloading the HMC machine code update to removable media

1. From a computer or server with an Internet connection, go to the Hardware Management
Console website at http://www-933.ibm.com/support/fixcentral/

2. Under Supported HMC products, select the latest HMC level.
3. Scroll down to the File name(s) / Package area and locate the update you want to download.
4. Click the update you want to download.
5. Accept the license agreement, and save the update to your removable media.

When you are finished, continue with “Step 4. Apply the HMC machine code update.”

Step 4. Apply the HMC machine code update
To apply the HMC machine code update, do the following:
1. Before you install updates to the HMC machine code, back up HMC data. For more information, see

“Backing up critical HMC data” on page 64
2. If you obtained or created the update on DVD-RAM, insert it into the DVD drive on the HMC. If you

obtained or created the update on a USB memory device, insert the memory device.
3. In the navigation area, click Updates.
4. Click Update HMC. The Install HMC Corrective Service Wizard opens.
5. Follow the instructions in the Wizard to install the update.
6. Shut down, restart, and log back in to the HMC for the update to take effect.
7. Continue with “Step 5. Verify that the HMC machine code update installed successfully.”

Step 5. Verify that the HMC machine code update installed successfully
To verify that the HMC machine code update installed successfully, do the following:
1. In the navigation area, click Updates. In the Work area, the HMC version, release, maintenance level,

build level, and base versions are displayed under the HMC Code Level heading.
2. Verify that the version and release match the update that you installed.
3. If the level of code displayed is not the level that you installed, perform the following steps:

a. Retry the machine code update. If you created a DVD for this procedure, use a new media.
b. If the problem persists, contact your next level of support.

Upgrading your HMC software
Learn how to upgrade the software on an HMC from one release to the next while maintaining your
HMC configuration data.

To upgrade machine code on an HMC, perform steps 1-9.

Note: If you are upgrading from HMC with Version 6 with HMC Version 7, refer to “Migrating the
machine code on an HMC from Version 6 to Version 7” on page 73.
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Step 1. Obtain the upgrade
You can order the HMC machine code upgrade through the Fix Central website.

To obtain the upgrade through the Fix Central website, do the following:
1. From a computer or server with an Internet connection, go to the Hardware Management Console

website at http://www-933.ibm.com/support/fixcentral/.
2. Click Continue. The Hardware Management Console site is displayed.
3. Navigate to the HMC version you want to upgrade to.
4. Locate the download and ordering section.

Note: If you do not have access to the Internet, contact IBM service and support to order the upgrade
on DVD.

5. Follow the on-screen prompts to submit your order.
6. After you have the upgrade, continue with “Step 2. View the existing HMC machine code level.”

Step 2. View the existing HMC machine code level
To determine the existing level of machine code on an HMC, follow these steps:
1. In the navigation area, click Updates.
2. In the Work area, view and record the information that appears under the HMC Code Level heading,

including the HMC version, release, maintenance level, build level, and base versions.
3. Continue with “Step 3. Back up the managed system's profile data.”

Step 3. Back up the managed system's profile data
To back up the managed system's profile data, do the following:
1. In the navigation area, select Systems Management.
2. Select Servers.
3. Select the server and ensure the state is Operating or Standby.
4. Under Tasks, select Configuration > Manage Partition Data > Backup.
5. Type a backup file name and record this information.
6. Click OK.
7. Repeat these steps for each managed system.
8. Continue with “Step 4. Back up HMC data.”

Step 4. Back up HMC data
Back up HMC data before installing a new version of HMC software so that previous levels can be
restored in the event of a problem while upgrading the software. Do not use this critical console data
after a successful upgrade to a new version of the HMC software.

Note: To back up to removable media, you will need to have that media available.

To back up HMC data, do the following:
1. If you plan to back up to media, perform the following steps to format the media:

a. Insert the media into the drive.
b. In the navigation area , select Service Management

c. Select Format Media.
d. Select the media type.
e. Select the format type.
f. Click OK.

2. In the navigation area, select HMC Management.
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3. Select Back up HMC Data. The Back up HMC Data window opens.
4. Select an archive option. You can back up to media on a local system, a remote system mounted to

the HMC file system (for example, NFS), or send the backup to a remote site using File Transfer
Protocol (FTP).
v To back up to a local system, choose Back up to media on local system and follow the instructions.
v To back up to a mounted remote system, choose Back up to mounted remote system and follow

the instructions.
v To back up to a remote FTP site, choose Send back up critical data to remote site and follow the

instructions.
5. Continue with “Step 5. Record the current HMC configuration information.”

Step 5. Record the current HMC configuration information
Before you upgrade to a new version of HMC software, as a precautionary measure, record HMC
configuration information.

To record the current HMC configuration, do the following:
1. To view scheduled operations for a managed system or its logical partitions, open Systems

Management. If you want to record scheduled operations for the HMC itself, select HMC
Management and skip to step 3.

2. Select a managed system and any partitions for which you want to record HMC configuration
information.

3. In the tasks list, select Schedule Operations. All scheduled operations for the target you selected are
displayed.

4. Select Sort > By Object.
5. Select each object and record the following details:
v Object Name
v Schedule date
v Operation Time (displayed in 24-hour format)
v Repetitive (if Yes, perform the following steps):

a. Select View > Schedule Details.
b. Record the interval information.
c. Close the scheduled operations window.
d. Repeat for each scheduled operation.

6. Close the Customize Scheduled Operations window.
7. Continue with “Step 6. Record remote command status.”

Step 6. Record remote command status
To record remote command status, do the following:
1. In the navigation area, select HMC Management.
2. In the tasks list, click Remote Command Execution.
3. Record whether the Enable remote command execution using the ssh facility check box is selected.
4. Click Cancel.
5. Continue with “Step 7. Save upgrade data.”

Step 7. Save upgrade data
You can save the current HMC configuration in a designated disk partition on the HMC or to local
media. Save upgrade data only immediately prior to upgrading your HMC software to a new release.
This action allows you to restore HMC configuration settings after upgrading.
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Note: Only one level of backup data is allowed. Each time you save upgrade data, the previous level is
overwritten.

To save upgrade data, do the following:
1. In the navigation area, select HMC Management.
2. In the content area under Operations, select Save Upgrade Data. The Save Upgrade Data Wizard

opens.
3. Select the media on which you want to save the upgrade data. If you choose to save to removable

media, insert the media now. Click Next.
4. Click Finish.
5. Wait for the task to complete. If the Save Upgrade Data task fails, contact your next level of support

before proceeding.

Note: If the save upgrade data task fails, do not continue the upgrade process.
6. Click OK.
7. Continue with “Step 8. Upgrade the HMC software.”

Step 8. Upgrade the HMC software
To upgrade the HMC software, restart the system with the removable media in the DVD drive.
1. Insert the HMC Product Installation media into the DVD drive.
2. In the navigation bar, select HMC Management.
3. In the content area, select Shutdown or Restart HMC.
4. Ensure Restart the HMC is selected.
5. Click OK. The HMC restarts and system information scrolls on the window.
6. Select Upgrade and click Next.
7. Choose from the following options:
v If you have saved upgrade data during the previous task, continue with the next step.
v If you did not save upgrade data previously in this procedure, you must save the upgrade data

now before you continue.
8. Select Upgrade from media and click Next.
9. Confirm the settings and click Finish.

10. Follow the prompts.

Note:

v If the screen goes blank, press the space bar to view the information.
v The first DVD can take approximately 20 minutes to install.

11. At the login prompt, log in using your user ID and password. The HMC code installation is
complete.

12. Continue with “Step 9. Verify that the HMC machine code upgrade installed successfully.”

Step 9. Verify that the HMC machine code upgrade installed successfully
To verify that the HMC upgrade installed successfully, do the following:
1. In the navigation area, click Updates. In the Work area, the HMC version, release, maintenance level,

build level, and base versions are displayed under the HMC Code Level heading.
2. Verify that the version and release match the update that you installed.
3. If the level of code displayed is not the level that you installed, retry the upgrade task using a new

DVD. If the problem persists, contact your next level of support.
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Migrating the machine code on an HMC from Version 6 to Version 7
Learn how to move the machine code on an HMC from Version 6 to Version 7 while maintaining your
HMC configuration data.

To migrate machine code on an HMC from Version 6 to Version 7, perform steps 1-9.

Important: To migrate to Version 7 Release 0, you must be at a minimum of HMC machine code Version
6 Release 1.2.

Ensure you have met the minimum requirements
To migrate the machine code on an HMC from Version 6 to Version 7, you must first ensure that you
have met the following minimum requirements:
v Your HMC is at level 6.12 or higher. For more information about checking your HMC code level and

release, see “Determining your HMC machine code version and release” on page 66.
v Your system firmware is at its latest level.
v You have performed the network integrity check
v Your HMC hardware supports this upgrade.

Step 1. Obtain the upgrade
To obtain the upgrade, do the following:

You can order the HMC machine code upgrade through the Fix Central website, by contacting service
and support, or by downloading it to an FTP server.
1. From a computer or server with an Internet connection, go to http://www.ibm.com/eserver/

support/fixes.
2. Select the appropriate family in the Product family list.
3. Select Hardware Management Console in the Product or fix type list.
4. Click Continue. The Hardware Management Console site is displayed.
5. Navigate to the HMC version you want.
6. Locate the download and ordering section.

Note: If you do not have access to the Internet, contact service and support to order the upgrade on
DVD.

7. Follow the prompts to submit your order.
8. After you have the upgrade, continue with “Step 2. View the existing HMC machine code level.”

Step 2. View the existing HMC machine code level
To determine the existing level of machine code on an HMC, follow these steps:
1. In the navigation area, click Licensed Internal Code Maintenance folder.
2. Select HMC Code Update.
3. In the Status area, look for the version and release of your HMC machine code.
4. Record the current version and release.

Important: To upgrade from HMC machine code 6.1.3 to 7.3.4.0, you must first apply a fix. For more
information, see http://www.ibm.com/eserver/support/fixes.

5. Continue with “Step 3. Back up the managed system's profile data.”

Step 3. Back up the managed system's profile data
To back up the managed system's profile data, do the following:
1. In the content area, select the managed system.
2. From the menu, click Selected > Profile Data > Backup.
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3. Type a backup file name and record this information.
4. Click OK.
5. Repeat steps 1 on page 73 through 4 for each managed system.

Step 4. Back up critical console information
Back up critical console information before installing a new version of HMC software so that previous
levels can be restored in the event of a problem while upgrading the software. Do not use this critical
console data after a successful upgrade to a new version of the HMC software.

Note: If you choose to back up the console data to removable media, you must have that media
available.

To back up critical console information, do the following:
1. Choose from the following options:
v If you do not plan to back up to DVD-RAM, continue with the next step.
v If you plan to back up to DVD-RAM, perform the following steps:

a. Insert the DVD-RAM into the drive.
b. In the navigation area, click Licensed Internal Code Maintenance.
c. Select HMC Code Update.
d. Select Format Removable Media.
e. Select Format DVD-RAM.
f. Click OK.
g. Continue with the next step.

2. Select Back up Critical Console Data.
3. Select an archive option. You can back up to a DVD in the HMC, a remote system mounted to the

HMC file system (for example, NFS), or send the backup to a remote site using File Transfer Protocol
(FTP).
v To back up to DVD, choose Back up to DVD on local system and follow the instructions.
v To back up to a mounted remote system, choose Backup to mounted remote system and follow the

instructions.
v To back up to a remote FTP site, choose Send backup critical data to remote site and follow the

instructions.
4. Continue with “Step 5. Record the current HMC configuration information.”

Step 5. Record the current HMC configuration information
Before you upgrade to a new version of HMC software, as a precautionary measure, record HMC
configuration information.

To record HMC configuration information, follow these steps:
1. To view scheduled operations for a managed system or its logical partitions, open Systems

Management. If you want to record scheduled operations for the HMC itself, select HMC
Management and skip to step 3.

2. Select a managed system and any partitions for which you want to record HMC configuration
information.

3. In the tasks list, select Schedule Operations. All scheduled operations for the target you selected are
displayed.

4. Select Sort > By Object.
5. Select each object and record the following details:
v Object Name
v Schedule date
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v Operation Time (displayed in 24-hour format)
v Repetitive (if Yes, perform the following steps):

a. Select View > Schedule Details.
b. Record the interval information.
c. Close the scheduled operations window.
d. Repeat for each scheduled operation.

6. Close the Customize Scheduled Operations window.
7. Continue with “Step 6. Record remote command status.”

Step 6. Record remote command status
1. In the navigation area, select HMC Management.
2. Select HMC Configuration.
3. In the tasks list, click Enable/Disable Remote Command Execution.
4. Record whether the Enable remote command execution using the ssh facility check box is selected.
5. Click Cancel.
6. Continue with “Step 7. Save upgrade data.”

Step 7. Save upgrade data
You can save the current HMC configuration in a designated disk partition on the HMC. Save upgrade
data only immediately prior to upgrading your HMC software to a new release. This action allows you to
restore HMC configuration settings after upgrading.

The upgrade data will be restored automatically during the installation procedure.

Note: Only one level of backup data is allowed. Each time you save upgrade data, the previous level is
overwritten.
1. In the navigation area, open the Licensed Internal Code folder.
2. Select HMC Code Update.
3. Select Save Upgrade Data.
4. Select DVD and click Continue.
5. Insert the DVD media into the drive.
6. Click Continue to start the task.
7. Wait for the task to complete. If the Save Upgrade Data task fails, contact your next level of support

before proceeding.

Note: If the save upgrade data task fails, do not continue the upgrade process.
8. Click OK.
9. Click Cancel.

10. Continue with “Step 8. Upgrade the HMC software from Version 6 to Version 7.”

Step 8. Upgrade the HMC software from Version 6 to Version 7

Important: To upgrade from HMC machine code 6.1.3 to 7.3.4.0, you must first apply a ptf. For more
information, see http://www.ibm.com/eserver/support/fixes.

To upgrade the HMC software, restart the system with the DVD-RAM in the DVD drive.
1. Insert the HMC Product Installation media.
2. Perform the following steps:

a. From the HMC menu bar, select Console > Exit.
b. Click Exit now.
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c. From the logout list, select Reboot Console and click OK. The HMC restarts and system
information scrolls on the window.

3. Select Upgrade and click Next.
4. When the warning is displayed, choose from the following options:
v If you have saved upgrade data during the previous task, continue with the next step.
v If you did not save upgrade data previously in this procedure, you must save the upgrade data

now before you continue.
5. Select Upgrade from media and click Next.
6. Confirm the settings and click Finish.
7. Follow the prompts.

Note:

v If the screen goes blank, press the space bar to view the information.
v The first DVD can take approximately 20 minutes to install.

8. When prompted, remove the first media and then insert the second media.
9. Select 1. Install additional software from media and press Enter. Press any key to confirm the

installation. The HMC will display status messages as it installs the packages.
10. Click Log on and launch the Hardware Management Console web application.
11. Log in to the HMC interface.
12. Continue with “Step 9. Verify that the HMC machine code upgrade installed successfully.”

Step 9. Verify that the HMC machine code upgrade installed successfully
1. In the navigation area, click Updates. In the Work area, the HMC version, release, maintenance level,

build level, and base versions are displayed under the HMC Code Level heading.
2. Verify that the version and release match the update that you installed.
3. If the level of code displayed is not the level that you installed, retry the upgrade task using a new

DVD. If the problem persists, contact your next level of support.

Step 10. Obtain an update package
You can order the HMC update packages through the Fix Central website, by contacting service and
support, or by downloading it to an FTP server.
1. From a computer or server with an Internet connection, go to http://www.ibm.com/eserver/

support/fixes.
2. Select the appropriate family in the Product family list.
3. Select Hardware Management Console in the Product or fix type list.
4. Click Continue. The Hardware Management Console site is displayed.
5. Navigate to the HMC version you want.
6. Locate the download and ordering section.

Note: If you do not have access to the Internet, contact service and support to order the upgrade on
DVD.

7. Follow the prompts to download the update package to removable media or submit your order.

Step 11. Reschedule operations for this HMC
When you upgrade the HMC, you must manually reschedule the operations you scheduled using the
previous HMC version.
1. In the navigation area, click HMC Management.
2. In the Work area, click Schedule Operations.
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Upgrading HMC from remote location using network upgrade images
Learn how to upgrade the software on an HMC from a remote location using network upgrade images.

Learn how to upgrade the software on an HMC from a remote location using network upgrade images.
Use the following procedure to upgrade HMC at level V6R1.2 or higher, which includes all HMC V7
levels.
1. From a computer or server with an Internet connection, go to the Hardware Management Console

website (http://www14.software.ibm.com/webapp/set2/sas/f/netinstall/v7770network.html)
2. Download the appropriate HMC V7 network images and save them on an FTP server. You cannot

download these files directly to the HMC. You must download the image files to a server that accepts
FTP requests.

3. Ensure that you download the following files:
v initrd.gz
v bzImage
v disk1.img
v disk2.img
v disk3.img
v hmcnetworkfiles.sum

4. Save the upgrade data on the HMC. Execute the following command lines to save the upgrade data:
v To save data on both DVD and HDD, execute the following commands:

mount /media/cdrom

saveupgdata -r diskdvd

v To save data on the HDD, execute the following command:
saveupgdata -r disk

5. Copy the upgrade files to the bootable disk partition on the HMC. Run the getupgfiles command to
copy the files.
Example: getupgfiles -h <ftp server> -u <user id> -d <remote directory>

Where,
v ftp server is the host name or ip address of the FTP server where you have downloaded the HMC

network images.
v user id is a valid user id on the FTP server. If you do not specify the password with the --passwd

argument, you will be prompted for a password.
v remote directory is the directory on your FTP server where the HMC network images are saved.

6. Reboot the HMC to upgrade the code copied to the bootable disk partition. Run the chhmc -c
altdiskboot -s enable --mode upgrade to reboot the HMC.

7. Reboot the HMC and start the upgrade. Run the hmcshutdown -r -t now command to start the
upgrade.

HMC port locations
You can find part locations by using location codes. Use the HMC port location illustrations to map a
location code to the HMC port position on the server.

8202-E4B or 8205-E6B HMC port locations

Use this diagram and table to map the HMC ports on an 8202-E4B or 8205-E6B.
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Table 13. 8202-E4B or 8205-E6B HMC port locations

Port Physical location code Identify LED

HMC port 1 Un-P1-T5 No

HMC port 2 Un-P1-T6 No

For more information on HMC port locations on the 8202-E4B or 8205-E6B, see Part location and location codes for
8202-E4B or 8205-E6B.

8202-E4C or 8205-E6C HMC port locations

Use this diagram and table to map the HMC ports on an 8202-E4C or 8205-E6C.

Figure 36. 8202-E4B or 8205-E6B HMC port locations

Figure 37. 8202-E4C or 8205-E6C HMC port locations
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Table 14. 8202-E4C or 8205-E6C HMC port locations

Port Physical location code Identify LED

HMC port 1 Un-P1-T5 No

HMC port 2 Un-P1-T6 No

For more information on HMC port locations on the 8202-E4C or 8205-E6C, see Part location and location codes for
8202-E4C or 8205-E6C..

8231-E2B HMC port locations

Use this diagram and table to map the HMC ports on an 8231-E2B.

Table 15. 8231-E2B HMC port locations

Port Physical location code Identify LED

HMC port 1 Un-P1-T3 No

HMC port 2 Un-P1-T4 No

For more information on HMC port locations on the 8231-E2B, see Part location and location codes for 8231-E2B.

8231-E1C or 8231-E2C HMC port locations

Use this diagram and table to map the HMC ports on an 8231-E1C or 8231-E2C.

Table 16. 8231-E1C or 8231-E2C HMC port locations

Port Physical location code Identify LED

HMC port 1 Un-P1-T3 No

HMC port 2 Un-P1-T4 No

For more information on HMC port locations on the 8231-E1C or 8231-E2C, see Part location and location codes for
8231-E1C or 8231-E2C

Figure 38. 8231-E2B HMC port locations

Figure 39. 8231-E1C or 8231-E2C HMC port locations
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8233-E8B or 8236-E8C HMC port locations

Use this diagram and table to map the HMC ports on an 8233-E8B or 8236-E8C.

Table 17. 8233-E8B or 8236-E8C HMC port locations

Port Physical location code Identify LED

HMC port 1 Un-P1-T7 No

HMC port 2 Un-P1-T8 No

For more information on HMC port location on 8233-E8B or 8236-E8C, see Part location and location codes for
8233-E8B or 8236-E8C

8408-E8D 8248-L4T or 9109-RMD HMC port locations

Use this diagram and table to map the HMC ports on an 8408-E8D 8248-L4T or 9109-RMD.

Table 18. 8408-E8D 8248-L4Tor 9109-RMD HMC port locations

Port Physical location code Identify LED

HMC port 1 Un-P1-C1-T6 Yes

HMC port 2 Un-P1-C1-T7 Yes

For more information on HMC ports on an 8408-E8D or 9109-RMD, see Part location and location codes for
8408-E8D or 9109-RMD.

Figure 40. 8233-E8B or 8236-E8C HMC port locations

Figure 41. 8408-E8D 8248-L4T or 9109-RMD HMC port locations
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9117-MMB or 9179-MHB HMC port locations

Use this diagram and table to map the HMC ports on a 9117-MMB or 9179-MHB.

Table 19. 9117-MMB or 9179-MHB HMC port locations

Port Physical location code Identify LED

HMC port 1 Un-P1-C1-T6 Yes

HMC port 2 Un-P1-C1-T7 Yes

For more information on HMC ports on a 9117-MMB or 9179-MHB, see Part location and location codes for
9117-MMB or 9179-HMC

9117-MMC, 9117-MMD, 9179-MHC, 9179-MHD, or HMC port locations

Use this diagram and table to map the HMC ports on a 9117-MMC, 9117-MMD, 9179-MHC, 9179-MHD,
or .

Table 20. 9117-MMC, 9117-MMD, 9179-MHC, 9179-MHD, or HMC port locations

Port Physical location code Identify LED

HMC port 1 Un-P1-C1-T6 Yes

HMC port 2 Un-P1-C1-T7 Yes

For more information on HMC ports on 9117-MMC, 9117-MMD, 9179-MHC, or 9179-MHD, see Part location and
location codes for 9117-MMC, 9117-MMD, 9179-MHC, or 9179-MHD

Figure 42. 9117-MMB or 9179-MHB HMC port locations

Figure 43. 9117-MMC, 9117-MMD, 9179-MHC, 9179-MHD, or HMC port locations
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9119-FHB HMC port locations

Use this diagram and table to map the HMC ports on a 9119-FHB.

Table 21. 9119-FHB HMC port locations

Port Physical location code Identify LED

HMC (Connector J02, Ethernet to
Bulk power hub-BPH)

Un-Px-C1–J02 No

HMC (Connector J03, Ethernet to
Bulk power hub-BPH)

Un-Px-C1–J03 No

For more information on HMC ports on 9119-FHB, see Part location and location codes for 9119-FHB

Figure 44. 9119-FHB HMC port locations
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�������: ����������������������������� A �������������������������������������������
������������������������������������ ����������������������������������������������

�������� VCCI - �������

������������������������������������� VCCI �����������������������������

������������������������������� A ���������������������� VCCI
������������������������������������������� ������������������������������������
����������������������������������������������

������������������������������������������������������� Japanese Electronics
and Information Technology Industries Association (JEITA)
(�������������������������������� ����������� 20 A ������)

������������������������������������������������������� Japanese Electronics
and Information Technology Industries Association (JEITA) ���������������������
(������������������������������� 20 A ������)

���������������������������������������������� (EMI) - �������������������

��������: ����������������������������� A ����������������������������������������������
������������������������������������ �������������������������������������������������
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���������������������������������������������� (EMI) - �������������

��������������������������������� EMI �����������������������

�������: ����������������������������� A
�����������������������������������������������������������������������������������
����������������������������������������������

IBM �������������������������������:

���������������������������������������������� (EMI) - ������������

���������������������������������������������

Deutschsprachiger EU Hinweis: Hinweis für Geräte der Klasse A EU-Richtlinie zur
Elektromagnetischen Verträglichkeit

Dieses Produkt entspricht den Schutzanforderungen der EU-Richtlinie 2004/108/EG zur Angleichung der
Rechtsvorschriften über die elektromagnetische Verträglichkeit in den EU-Mitgliedsstaaten und hält die
Grenzwerte der EN 55022 Klasse A ein.

Um dieses sicherzustellen, sind die Geräte wie in den Handbüchern beschrieben zu installieren und zu
betreiben. Des Weiteren dürfen auch nur von der IBM empfohlene Kabel angeschlossen werden. IBM
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übernimmt keine Verantwortung für die Einhaltung der Schutzanforderungen, wenn das Produkt ohne
Zustimmung von IBM verändert bzw. wenn Erweiterungskomponenten von Fremdherstellern ohne
Empfehlung von IBM gesteckt/eingebaut werden.

EN 55022 Klasse A Geräte müssen mit folgendem Warnhinweis versehen werden:
"Warnung: Dieses ist eine Einrichtung der Klasse A. Diese Einrichtung kann im Wohnbereich
Funk-Störungen verursachen; in diesem Fall kann vom Betreiber verlangt werden, angemessene
Maßnahmen zu ergreifen und dafür aufzukommen."

Deutschland: Einhaltung des Gesetzes über die elektromagnetische Verträglichkeit von Geräten

Dieses Produkt entspricht dem “Gesetz über die elektromagnetische Verträglichkeit von Geräten
(EMVG)“. Dies ist die Umsetzung der EU-Richtlinie 2004/108/EG in der Bundesrepublik Deutschland.

Zulassungsbescheinigung laut dem Deutschen Gesetz über die elektromagnetische Verträglichkeit von
Geräten (EMVG) (bzw. der EMC EG Richtlinie 2004/108/EG) für Geräte der Klasse A

Dieses Gerät ist berechtigt, in Übereinstimmung mit dem Deutschen EMVG das EG-Konformitätszeichen
- CE - zu führen.

Verantwortlich für die Einhaltung der EMV Vorschriften ist der Hersteller:
International Business Machines Corp.
New Orchard Road
Armonk, New York 10504
��������: 914-499-1900

Der verantwortliche Ansprechpartner des Herstellers in der EU ist:
IBM Deutschland GmbH
Technical Regulations, Abteilung M372
IBM-Allee 1, 71139 Ehningen, Germany
��������: +49 7032 15 2941
�����: lugi@de.ibm.com

Generelle Informationen:

Das Gerät erfüllt die Schutzanforderungen nach EN 55024 und EN 55022 Klasse A.

����������������������������������������������sinvctromagnetic Interference
(EMI) - �������������

������������������������������ B
������������������������������ B ���������������������������������������������
������������������������������ (EMC) ���� B ���������������������������
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����������������������������������������������� (Federal Communications
Commission - FCC)

������������������������ ���������������������������������������������� B ���������� 15 ��� ��
FCC
��������������������������������������������������������������������������������������������
�����������������������������������������������

������������������������������� ������ �����������������������
�������������������������������������������������
������������������������������������������������������������������ ������������
�������������������������������������������� ����������

������������� �������������������������������������������������������� ������������
���������������������������������������� ������
������������������������������������������������������������������:
v �������������� ����������������

v ������������������������������������������

v �����������������������������������������������������������������

v ������������������������������������� IBM ������������������������������������

�������������������������������������������� �������������������������������������
������������������� ������������������������������ ����������������������� FCC
����������������������������������������������������������������������������������� IBM IBM
����������������������������������������������������������������������
���������������������������������������������������������
�������������������������������������������� ���������������������������������������������������

���������������������������� 15 ����� FCC ������������������������������������������������: (1)
������������������������������������������������ ��� (2)
������������������������������������������������������
����������������������������������������������������������

������������������������������������������������

�������������� ���� B ���������������������� ICES-003 ���������

Avis de conformité à la réglementation d'Industrie Canada

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

��������������������������������������������

���������������������������������������������� EU Council Directive 2004/108/EC
����������������������������������������������������������������������������������� IBM
������������������������������������������
�������������������������������������������������������������������������������������� ������
���������������� �������������������� IBM

�������������������������� �������������������������������������������������������������� B
��������������� EN 55022 ������������� ����������������� B
������������������������������������������������������������������
�������������������������������������������������������������������������������������������������
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��������������������������:
IBM Deutschland GmbH
Technical Regulations, Department M372
IBM-Allee 1, 71139 Ehningen, Germany
��������: +49 7032 15 2941
�����: lugi@de.ibm.com

�������� VCCI - �������

������������������������������������������������������� Japanese Electronics
and Information Technology Industries Association (JEITA)
(����������������������������� ����������� 20 A ������)

������������������������������������������������������� Japanese Electronics
and Information Technology Industries Association (JEITA) ���������������������
(���������������������������� 20 A ������)

������������ IBM ���������������

���������������������������������������������� (EMI) - ������������
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���������������������������������������������

Deutschsprachiger EU Hinweis: Hinweis für Geräte der Klasse B EU-Richtlinie zur
Elektromagnetischen Verträglichkeit

Dieses Produkt entspricht den Schutzanforderungen der EU-Richtlinie 2004/108/EG zur Angleichung der
Rechtsvorschriften über die elektromagnetische Verträglichkeit in den EU-Mitgliedsstaaten und hält die
Grenzwerte der EN 55022 Klasse B ein.

Um dieses sicherzustellen, sind die Geräte wie in den Handbüchern beschrieben zu installieren und zu
betreiben. Des Weiteren dürfen auch nur von der IBM empfohlene Kabel angeschlossen werden. IBM
übernimmt keine Verantwortung für die Einhaltung der Schutzanforderungen, wenn das Produkt ohne
Zustimmung von IBM verändert bzw. wenn Erweiterungskomponenten von Fremdherstellern ohne
Empfehlung von IBM gesteckt/eingebaut werden.

Deutschland: Einhaltung des Gesetzes über die elektromagnetische Verträglichkeit von Geräten

Dieses Produkt entspricht dem “Gesetz über die elektromagnetische Verträglichkeit von Geräten
(EMVG)“. Dies ist die Umsetzung der EU-Richtlinie 2004/108/EG in der Bundesrepublik Deutschland.

Zulassungsbescheinigung laut dem Deutschen Gesetz über die elektromagnetische Verträglichkeit von
Geräten (EMVG) (bzw. der EMC EG Richtlinie 2004/108/EG) für Geräte der Klasse B

Dieses Gerät ist berechtigt, in Übereinstimmung mit dem Deutschen EMVG das EG-Konformitätszeichen
- CE - zu führen.

Verantwortlich für die Einhaltung der EMV Vorschriften ist der Hersteller:
International Business Machines Corp.
New Orchard Road
Armonk, New York 10504
��������: 914-499-1900

Der verantwortliche Ansprechpartner des Herstellers in der EU ist:
IBM Deutschland GmbH
Technical Regulations, Abteilung M372
IBM-Allee 1, 71139 Ehningen, Germany
��������: +49 7032 15 2941
�����: lugi@de.ibm.com

Generelle Informationen:

Das Gerät erfüllt die Schutzanforderungen nach EN 55024 und EN 55022 Klasse B.

������������������
������������������������������������������������ �������������������

���������������������: ���������������������������
��������������������������������������������������������������������������������� IBM IBM

������������������: ����������������������������������������������������������
�������������������� �����������������������������������������������������������������
������������������� ���� ������������ �����������������������������
��������������������������������� �������������������������������������������� IBM IBM.
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����������������������: �������������������, �������, �����������������������������������������
�����������������������������������������������������������������
������������������������������������������������� ����������������� �������
���������������������� ����������������������������������������������
�������������������������������������������� IBM IBM.

������: ���������������������������������������� ������������������������������
������������������������ ��������������������������������������������������� �������� ������
��������� �������������������������� ������������������

�������
������������������������������������������������������������������������������������������������������������������������
���������������������� ��������� IBM �������������������������������������������
����������������������

��������������������� ������ ������������������������������
������������������������������������������������
���������������������������������������������������������

������������������������������������������������������ ��������������������������
"��������������" ����������������������� ����������������������������
���������������������������������������� ��������������� ������������ ��������������
��������������������������
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